Welcome to NX

December 2019

Dear Customer:

We are proud to introduce the latest release of NX, which brings significant new and enhanced functionality in all areas of the product to help you work more productively in a collaborative managed environment. This release builds on the continuous release process that is designed to make it easier for you to stay current with the latest releases of NX, giving you faster access to the latest functionality, and performance and quality improvements, to ensure that you gain the most from your investments.

Design

To optimize product development, we have invested in all aspects of modeling, including core functionality in modeling and drafting. New powerful weight management capabilities allow you to manage the mass properties of your entire product. We have also combined Direct Sketch and the Sketch task environment to make user interaction in sketching easier. In addition, to support the increasing use of reverse engineering, we are pleased to introduce new tools in convergent modeling to read point clouds and combine facet bodies.

Manufacturing

This latest release of NX CAM brings innovative machining methods, higher levels of automation, and cloud-based postprocessing technology, including the following highlights:

• A new 5-axis roughing, powered by the high-speed Adaptive Milling technology, significantly reduces machining time of complex parts. By using deep cuts at high cutting speeds, it enables material to be rapidly removed as it gets closer to the final shape of the part, reducing the finishing cycle times.

• Multiple robots can be now programmed and simulated using NX CAM, enabling expanded automation on the shop floor.

• Machining Line Planner streamlines the allocation of operations across multiple machines while optimizing the machining processes.

• Post Hub, the new cloud-based solution for post processing, is directly accessible from within NX CAM. Free to NX CAM users, it provides more than 600 postprocessors for a wide range of machine/controller configurations, enabling you to quickly generate production-ready NC programs.

We are confident that the new capabilities in this release will allow you to work more productively than ever before, and to achieve your product requirements while staying at the forefront of industry trends. For more information about this release, see the What’s New Guide included with the NX help.

–Your NX team
Contents

Welcome to NX 3

NX System Information
Customer support 1-1
Platforms 1-1
  NX central runtime directory 1-1
  System requirements guidelines 1-3
  Operating system requirements 1-6
  Supported hardware and graphics 1-11
  NX Open programs on Linux 1-12
  Initializing the JVM 1-13
  NX variables in the ugii_env.dat file 1-15
Browser requirements 1-17
  Browser and plug-in requirements 1-17
  Browser caveats 1-19
Licensing Caveats 1-20
  General licensing caveats 1-20
  Licensing caveats for Windows 1-21
  Licensing caveats for Linux 1-22
Product compatibility - supported version combinations 1-23
NX compatibility with Spreadsheet 1-26
NX applications unsupported on specific platforms 1-27
Support for touch enabled devices 1-28

NX Caveats and Product Notes
Teamcenter Integration for NX 2-1
  Product Notes 2-1
  Caveats 2-2
Fundamentals 2-2
  Product Notes 2-2
  Caveats 2-4
Customer Defaults 2-4
  Customer defaults 2-4
Design (CAD) 2-5
  Modeling 2-5
  Assemblies 2-5
  Drafting 2-7
  Layout 2-8
  Product and Manufacturing Information (PMI) 2-9
  Routing 2-9
  Sheet Metal 2-10
  Human Modeling 2-12
Contents

NX 1899 Release Notes
© 2019 Siemens

PCB Exchange 2-12
Manufacturing (CAM) 2-12
  Manufacturing Product Notes 2-12
  Manufacturing caveats 2-22
  Fixture Planner 2-30
  Line Designer 2-32
  Additive Manufacturing 2-37
  Additive Manufacturing Process Simulation 2-39
  CMM Inspection Programming 2-40
Knowledge Fusion and DesignLogic functions 2-46
  Product Notes 2-46
Validation 2-48
  Check-Mate and Requirements Validation 2-48
Tooling Design 2-49
  Tooling Design documentation notes 2-49
  Press Die Checker 2-49
  OmniCAD 2-49
  Mold Wizard 2-49
  Progressive Die Wizard 2-50
Data translation 2-51
  Product Notes 2-51
  Caveats 2-53
System Administration 2-61
  Updating the NX Installation 2-61
Mechatronics Concept Designer 2-61
  Product Notes 2-61
Automation Designer 2-62
  Requirements for running Automation Designer NX 1899 2-62
  Caveats 2-64
  Documentation Notes 2-67
Programming Tools 2-67
  Open C 2-67
  NX Open 2-69
  Release upgrades 2-70
  Product Notes 2-73
1. NX System Information

Customer support

Customers covered by valid maintenance agreements are eligible to receive support from the Global Technical Access Center (GTAC). If you are a customer of one of our partners or resellers, please contact them first to determine your first line support provider.

GTAC has the following mission: To increase our customer’s productive use of our software by providing responsive and specialized support. You can find your local support center contact phone numbers and additional information on support services by visiting our GTAC page at http://www.siemens.com/gtac.

Platforms

NX central runtime directory

Central runtime directory concept

To help you find executables and libraries, and distinguish them from configuration files more easily, a central runtime directory that contains DLLs (or so’s, or dylib’s), executables, and JAR files is now used. The central runtime directory will be updated as NX supports more and different applications.

Scripts that are used to wrap executables have not been moved and they are still in their original kit locations with the configuration files.

NXBIN directory

The central runtime directory, NXBIN, is created on all platforms at the \UGII_BASE_DIR\nxbin location during the NX installation. Depending on what was selected to be installed, libraries and executables from different kits are consolidated into the central runtime directory during the install process.

The new NX runtime directory does not contain all binaries and executables. Only the most frequently used files from the following directories have been moved:

- UGI
- UGMANAGER
- STEP203UG
- STEP214UG
- PVTRANS
Other files will also be moved over time. However, some applications, such as NX Nastran, will not be moved.

While NXBIN does not contain all of the executables and DLL's, it does contain a large quantity and is a prime location to search for an executable or library.

**UGII_ROOT_DIR obsoleted**

UGII_ROOT_DIR has historically been used to find the following in the UGII directory:

- Libraries and executables
- Configuration files

With the creation of the central runtime directory, there are two different locations for these files (nxbin and ugii), so the concept of UGII_ROOT_DIR is obsoleted. Use the UGII_BASE_DIR variable instead when you write custom application code and scripts.

While the NX install no longer sets UGII_ROOT_DIR, the definition on the system will remain to support earlier releases. If your code or scripts rely on UGII_ROOT_DIR, modify them to ensure they still work in this release.

**Teamcenter code and scripts**

To provide backward compatibility with released versions of Teamcenter, all executables called directly by Teamcenter code or scripts are wrapped.

The wrapper executables just correct the settings of the UGII_BASE_DIR, PATH, and LD_LIBRARY_PATH variables that are set by the Teamcenter scripts and code, and then start up the real executable from the NXBIN directory. This enables support for the new runtime concept, while allowing NX to run with existing versions of Teamcenter.

These new wrapper executables must remain in the ugii and ugmanager directories since that is where Teamcenter code expects to find them. Two processes are shown for executables invoked from the ugii and ugmanager directories.

Executables are still in the UGII, UGMANAGER, STEP203UG, STEP214UG, and PVTRANS kits.

Teamcenter code migration to the new central runtime directory structure is scheduled in a future Teamcenter release.
System requirements guidelines

Defining the minimum system requirements is difficult because key requirements, most notably memory, can vary dramatically from user to user. The following are general guidelines that you should consider before purchasing a system.

Processor performance

Although raw processor speed has a major impact on system performance, other factors also contribute to overall performance; for example, the type of disk drive (SCSI, ATA, or Serial ATA), disk speed, memory speed, graphics adapter, and bus speeds. The general rule is that "the faster the processor, the better the performance is," but this only applies when comparing like architectures. For example, it is difficult to arrive at performance expectations for an Intel processor when compared to an AMD processor just by looking at their respective processor speeds. There is also a general trend today to de-emphasize processor speeds and move to multi-core processors, which actually can have lower processor speeds.

NX takes advantage of modern processors, and if a processor does not have the required functionality, you will see the following error message and NX will not run on the installed CPU:

This processor is too old and not supported anymore

SMP

Symmetric Multiprocessing (SMP) is supported in NX mostly via Parasolid, although a small number of NX capabilities have some threading. In general, it is not possible to quote a figure for the general performance improvement achieved by using SMP, since this improvement depends on the nature of the operations you are performing. You need to evaluate your actual performance gains using your own models. Functional areas that are SMP enabled in Parasolid include:

- Validity checking
- Boolean operations
- Wireframe
- Rendering
- Hidden line rendering
- Closest approach
- Faceting
- Mass properties
SMP is enabled by default with the variable `UGII_SMP_ENABLE`, which is located in the `ugii_env_ug.dat` file.

**Multi-Core**

Multi-core processors are similar to SMP because there are two or more actual processor cores but they are delivered in single processor packages. Siemens PLM Software has found that multi-core performance characteristics are similar to SMP. The one advantage of multi-core processors over SMP is that this technology has proliferated much faster than SMP and is now common in workstations, servers, and laptops.

Multi-core technology is complex and, depending on the configuration, can actually have a negative impact on performance. This is due to the potential conflict of multiple cores sharing system resources, such as cache, memory, and bus bandwidth, as well as the need for the system to manage and control an increasing number of cores. Increasing the number of cores does not always translate into better performance. Although additional cores can improve NX performance, processor speed is still a vital measurement of NX performance.

Many systems enable you to turn off cores via the BIOS, which can enable you to compare performance with a different number of cores that are active. Some users may find that turning off some cores will actually improve performance. One micro-architecture (Intel) even does this automatically, shutting down unused cores and increasing the clock speed of the others.

The hardware vendors continue to improve their processor micro-architectures to better address the limitations of older multi-core technologies. New subsystems better integrate memory and other peripherals directly to the processors, resulting in major performance improvements. Buses are being eliminated, cores are better managed, and channel speeds continue to improve.

In summary:

- Turn SMP on only if you have an SMP system. Having it on in a single-processor system incurs a slight overhead.
- Turn SMP on if you have a multi-core system.
- Never assume that by simply adding more cores you will see better performance. Always test first.

**Memory**

The minimum recommended amount of memory to run native NX is 8GB. If you are running NX with Teamcenter (Teamcenter Integration for NX), the minimum recommended is 12 GB. However, because NX is capable of handling large assemblies and very complex parts, many of our customers use workstations with 32GB of RAM, and some even use 64GB, 96GB, or more.

For the optimum user experience and application performance, we recommend that you install as much RAM as can be installed in the client workstation that is running NX.
As a guideline, so that you get the best possible performance when using NX, ensure that the amount of physical memory (RAM) in your workstations is always larger than the amount of memory consumed by NX, plus all the other applications that are running at the same time on the same machine. This can be done by using a tool such as Windows Task Manager or Resource Monitor.

The minimum memory requirements varies and depends on various factors including:

- Complexity of the geometry within individual parts
- Size of the assemblies that are loaded
  - Less memory is required if the assemblies contain multiple instances of the same components.
  - More memory is required when large assemblies contain lots of unique components with complex geometry.
- Use of Teamcenter in addition to NX
  - Some additional memory is required when using Teamcenter 4-tier.
  - A even greater amount of memory is required when using Teamcenter 2-tier.
- Fully loading exact assemblies versus using lightweight assemblies and partial loading
- Generating CAM toolpaths for very complex geometry, such as an automotive engine block or gearbox
- Updating large assembly drawings

**Graphics adapters**

All the NX certified systems contain graphics adapters that meet all Siemens PLM Software requirements and are fully supported by our hardware partners. The graphics adapters supported are carefully selected by working with our OEM partners as well as our graphics vendor partners. We do not recommend low-end, consumer, or game cards, since these graphics devices are developed for the DirectX market and are not well supported under OpenGL. Because a majority of platform/hardware problems are graphics related, it is critical that all the graphics adapters that NX supports are designed for OpenGL and have the highest level of support from our hardware vendors. We highly recommend that you only use supported graphics adapters and Siemens PLM Software certified drivers.

For the latest information on certified graphics cards and driver versions, please visit the Customer Support (GTAC) Web site.
Multiple monitors

Siemens PLM Software supports multi-monitors but with limitations. These limitations were necessary due to the large number of possible configurations. Other combinations may work, but these conditions are tested and supported by Siemens PLM Software. These guidelines could be extended or relaxed in the future.

The following is a summary of findings for the support of multiple monitors.

- NX 6.0.1 or higher - no older releases are supported.
- Two monitors only.
- LCD monitors only
- Run with native resolution and aspect ratio.
- Laptops are tested without docking stations or port replicators (direct connection only).
- Horizontal Scan mode (not Vertical) and only with identical monitors.
- Dual View (Nvidia) or Extended View (ATI) modes, but the user must have the display window entirely in either the primary or secondary monitor.

You do not have to comply with the configurations mentioned above, but Siemens must be able to duplicate the problem on the configurations in our labs before being able to investigate your issues.

Operating system requirements

This section documents operating system and service pack requirements.

Minimum Operating Systems

The following operating systems are the minimum recommended for NX. Newer versions and service packs are available as they are released.

<table>
<thead>
<tr>
<th>O.S.</th>
<th>Version</th>
</tr>
</thead>
<tbody>
<tr>
<td>Microsoft Windows</td>
<td>Microsoft Windows 10 Pro and Enterprise editions</td>
</tr>
<tr>
<td>(64-bit)</td>
<td></td>
</tr>
<tr>
<td>Linux (64-bit)</td>
<td>SuSE Linux Enterprise Server/Desktop 12 SP1</td>
</tr>
<tr>
<td></td>
<td>Red Hat Enterprise Linux Server/Desktop 7.6</td>
</tr>
</tbody>
</table>
Linux

Starting in NX 1847, NX is no longer supported on the Linux operating system for interactive NX (NX running with UI), which includes graphics and XESS integration. It is only supported for running solvers and NX Open batch programs with no user interface calls.

Contact GTAC for the new NX Linux product.

Mac OS X

Starting in NX 1847, the Mac OS X operating system is no longer supported.

Windows 10

Windows 10 is the minimum supported release for NX 1899. The supported versions of Windows 10 are the Pro and Enterprise editions utilizing Semi-Annual Channel (SAC) updates.

Windows 10 is also available for NX 10.0.3 and later versions up to NX 1899. Any caveats or special instructions are provided in the SFB announcing support.

Windows 7 and 8.1

Windows 7 has reached the end of life and mainstream support has ended. Windows 8.1 is still supported by Microsoft, but was rarely deployed. These two versions of Windows are no longer supported by NX 1899. Siemens PLM Software has not performed testing on these versions and cannot resolve any issues related to NX 1899 running on these operating systems. If NX 1899 is deployed on these versions of Windows, any issues will have to be replicated on Windows 10 before filing an incident report with GTAC.

Windows XP and Vista

Windows XP support from Microsoft has ended and Vista was rarely deployed so these two versions of Windows are not supported by NX 1899. Siemens PLM Software has not performed testing on these versions and cannot resolve any issues related to NX 1899 running on these operating systems. If NX 1899 is deployed on these versions of Windows, any issues will have to be replicated on Windows 10 before filing an incident report with GTAC.

System error when running NX

If you receive the following system error when launching NX, the problem is generally that the operating system is not up-to-date for the required and optional updates. This error can occur with Windows 7 and Windows 8.1.

The program can't start because api-ms-win-crt-heap-l1-1-0.dll is missing from your computer.
The error occurs when there are missing Visual C++ libraries due to a dependency on the Universal CRT libraries in Visual C++ 2015. To fix the problem, install the **Visual C++ 2015 update 3 redistributable** from Microsoft. The 64-bit redistributable (vc_redist.x64.exe) is available in the INSTALL folder of the NX runtime environment after installation, or you can download the redistributable from Microsoft.

If you still have a problem, contact GTAC support.

**Linux Distributions**

NX is developed using Linux standards and accepted Linux development conventions. Quality assurance testing is performed on the two versions of Linux listed in the table above. Siemens PLM Software cannot guarantee operation, performance, compatibility, or support on any other distributions.

The following is a list of information about the development environment (for reference only):

<table>
<thead>
<tr>
<th>Kernel</th>
<th>kernel 3.10.0-957.el7.x86_64</th>
</tr>
</thead>
<tbody>
<tr>
<td>C, C++ Compiler</td>
<td>gcc 4.8.5</td>
</tr>
<tr>
<td>Java Development version</td>
<td>1.8.0_45</td>
</tr>
</tbody>
</table>

**Considerations and caveats**

**Linux Requirements**

NX supports SuSE Linux and Red Hat Linux, both 64-bit only. The minimum supported version of SuSE Enterprise (Desktop/Server) is 12 SP1 and Red Hat Enterprise (Desktop/Server) is 7.6. Newer versions will be supported via certification.

Visit the [Customer Support (GTAC) Web site](http://www.gtac.siemens.com) for details of supported hardware configurations as well as for the latest graphics drivers.

**Java Runtime Environment**

The Java Runtime Environment (JRE) is not shipped with NX, but NX does require JRE 8 for certain products. To install the JRE, visit the Oracle download site at [http://java.com/en/download/index.jsp](http://java.com/en/download/index.jsp), or the [AdoptOpenJDK](https://adoptopenjdk.net/) site at [https://adoptopenjdk.net/](https://adoptopenjdk.net/).

Java is used for the following products:

- NX Relations Browser
- Manufacturing – Process Studio Author
- Command line version of the following translators:
  - CATIA V4
• CATIA V5
• Dxfdwg
• IGES
• NX Pro E
• Step AP203
• Step AP214
• Knowledge Fusion ICE
• Quality Dashboard
• Validation Rule Editor
• Simcenter 3D Batch Mesher
• Simcenter 3D Response Analysis Function Tools
• Simcenter 3D Report Writer
• Customer written NX Open Java programs

Java requirements for NX Open

NX Open for Java is designed to be used with Java version 1.8.0_45 or higher.

Post Processing of Abaqus ODB format results

In the NX release, NX uses Abaqus version 6.12 libraries to process ODB results files. For NX to use these libraries, you must first install Visual C++ 2008 X64 Runtime – v9.0.30729.4967.

Note:
If you have Abaqus version 6.12 installed on your system, the required Visual C++ runtime should already be installed.

You can download this runtime from the Simulia customer support website: http://www.3ds.com/products-services/simulia/support/

For more information on the system requirements for ODB version 6.12 files, see: http://www.3ds.com/support/certified-hardware/simulia-system-information/abaqus-612/system-requirements-for-abaqus-612-products
Running Samcef in parallel

On Windows, when you run parallel computations with the built-in Samcef solver, Python 2.7 is required. In NX 1899, that version of Python is not present. Install Python 2.7 on your disk and ensure that the Python directory is named **Python27** (default name) and is included on your PATH variable.

You can download the software from the Python website: [https://www.python.org/downloads/](https://www.python.org/downloads/)

**Note:**
The Python requirement does not apply if you have Samcef installed separately from NX.

Configuration files

Starting with NX 12, the NX configuration files on Windows are written to `C:\users\<name>\AppData\Local\Siemens`.

Installing the .NET Framework

The NXOpen for .NET API is a Windows-specific project that leverages the Microsoft .NET Framework component. Before you can execute a custom .NET application, you must install the .NET Framework 4.6.2. In addition, to replay a .NET journal, the .NET Framework 4.6.2 must be installed.

To download the .NET Framework 4.6.2, use the links on this page: [Microsoft .NET Framework 4.6 (Web Installer)](https://go.microsoft.com/fwlink/?LinkId=264680).

Visual Studio runtime redistributable

To run NX 1899, the MS Visual Studio 2017 runtime redistributable is required. In addition, the MS Visual Studio 2013 runtime redistributable is required to properly setup some system dll files for some of the older executables.

You can download the Visual Studio 2017 redistributable [here](https://go.microsoft.com/fwlink/?LinkId=267536).

You can download the Visual Studio 2013 redistributable [here](https://go.microsoft.com/fwlink/?LinkId=258898).

**Note:**
If you have MS Visual Studio 2017 and 2013 installed, you don't need to download and install the redistributable.
Supported hardware and graphics

The list of currently supported hardware and graphics cards can be found on the GTAC support page Customer Support (GTAC) Web site at Hardware and Software Certification—Hardware (Graphics Card) Certifications. This opens a spreadsheet that has tabs for supported systems and graphics.
NX Open programs on Linux

If you try to link an external NX Open C++ program using the `ufmenu` and `uflink` scripts with NX 1899 on SLES 12 SP1, Linux may fail with an error message such as:

/usr/x86_64-suse-linux/bin/ld: cannot find -lelf

For NX to properly build an NX Open program, you must have the correct RPM kits installed.

For NX 1899 and SUSE 12 SP1, the following packages are required:

```
elfutils-0.158-6.1.x86_64.rpm
libelf1-0.158-6.1.x86_64.rpm
libelf-devel-0.158-6.1.x86_64.rpm
```

For NX 1899 and RedHat 7.6, the following packages are required:

```
elfutils-libelf-0.172-2.el7.x86_64.rpm
elfutils-libelf-devel-0.172-2.el7.x86_64.rpm
elfutils-devel-0.172-2.el7.x86_64.rpm
elfutils-libelf-0.172-2.el7.x86_64.rpm
elfutils-libs-0.172-2.el7.x86_64.rpm
```

**Note:**

For SUSE, the `devel` packages are available from the optional SLE 12 SP1 SDK DVD/ISO.
Initializing the JVM

In some cases, NX is not able to create the Java Virtual Machine (JVM) properly on Windows. The root cause in these scenarios is insufficient memory to start the JVM. In most cases of insufficient memory Java is able to report back an error code indicating this problem. However, in some cases Java reports a generic error message that NX then displays. The typical error message is:

Can’t initialize the Java Virtual Machine (JVM)

When running a Java application, such as the Wave Browser or Interactive Class Editor, NX may give an unexpected error due to this problem.

If NX detects that there is not enough memory available for the JVM, an error message is given and information is provided in the syslog. The following is an example of the syslog information:

The JVM could not be created due to not enough memory.
The Java heap size must be contiguous and the largest contiguous block available is outputted below.
Windows largest block free
=================================
Maximum block 267Mb
=================================
Please note, this number is to be used as suggestion for setting the heap size. It is unlikely that you will be able to utilize the full amount.
If you need a heap size larger than what is possible you can try to use the /3GB switch or its equivalent, if available for the Operating System you are on.
Otherwise your other option is to use Remoting. Please consult the NX Open Programmer's Guide for more information on this topic.

Reset the size of the Java heap

To remedy this problem, you can reset the size of the Java heap that NX uses. Choose File→Execute→Override Java Parameters to open the dialog box and set UGII_JVM_OPTIONS to the size of the Java heap. You can experiment with the size of heap that you need, but if the JVM is already started then you cannot change the UGII_JVM_OPTIONS setting.

It is recommended that you use both the –Xmx and –Xms options together. Both of these are needed as Java may determine default values for the heap size that are not possible with the machine's current memory load. For example:

UGII_JVM_OPTIONS=–Xmx50M –Xms50M
When trying to determine the size of the heap, keep in mind that if the heap size is too small, a Java program you are trying to run may not run. This could be due to the amount of memory available on the machine, or due to multiple Java processes running. This can be the case with the Wave Browser where there is a client and server process.

Once you find a value that works, you can modify the UGII_JVM_OPTIONS value in the ugii_env.dat file so you don’t have to reset it in the NX Open Java Parameters dialog box each time you start an NX session.
NX variables in the ugii_env.dat file

Standard and modified environment variables

The ugii_env_ug.dat file contains the standard environment variables for NX. You can override these variables with the ugii_env.dat file. This file is essentially empty when delivered. You can define new values for the environment variables in this file and they take precedence over the values defined in the ugii_env_ug.dat file.

The ugii_env.dat file should be used to modify any standard NX environment variables or add new ones.

Both the ugii_env_ug.dat and ugii_env.dat files are located at <UGII_BASE_DIR>\ugii.

Note:
You can make all, some, or none of the changes to the variables in the ugii_env_ug.dat file. However, it is recommended that you use the ugii_env.dat file to define all of the values in use at your site.

Using the ugii_env.dat file

The following apply when using the ugii_env.dat file:

• Define the variables before the #include statement.

• The first variable defined is used. If you have the variable defined twice in the file, only the first one is used.

  Note:
  This also applies to the ugii_env_ug.dat file.

• You cannot have spaces in the variable names.

Designate a single ugii_env.dat file for all users

You can place the ugii_env.dat file in a central location for all users to access.

For each user, set the environment variable UGII_ENV_FILE to the location of the file. For example:

  UGII_ENV_FILE=G:\common\version_env_vars.corp_standards
Note:
The file can have any name but must be a fully qualified path.

Statements you can use in the ugii_env.dat file

The statements that you can use in the `ugii_env.dat` file are shown below with examples:

- **#if/#else/#endif**
  Used to check for specific conditions and then to define variables based on those conditions. Conditions that can be checked are:

- **FILE** - Check for the existence of a file

  ```
  #if FILE ${UGII_BASE_DIR}\UGII\html_files\start_${UGII_LANG}.html
  UGII_CAST_HOME=${UGII_BASE_DIR}\UGII\html_files\start_$
  {UGII_LANG}.html
  #else
  UGII_CAST_HOME=${UGII_BASE_DIR}\UGII\html_files\start_english.html
  #endif
  ```

- **platform** - Check for a specific platform. Possible values:

  - `x64wnt`
  - `lnx64`
  - `macosx`

  ```
  #if lnx64
  UGII_CAM_THREAD_MILL=${UGII_CAM_THREAD_MILL_DIR}thrm.so
  #endif
  ```

- **$variable = “value”** - Check for a specific value for a previously defined environment variable

  ```
  #if $UGII_LANG = "simpl_chinese"
  UGII_COUNTRY=prc
  UGII_COUNTRY_TEMPLATES=${UGII_BASE_DIR}\localization\$UGII_COUNTRY\simpl_chinese
  #endif
  ```

- **$variable != “value”** - Check for a previously defined environment variable that does not have the specified value.

  ```
  #if ${UGII_PACKAGE_DIRECTORY} != ""
  #if FILE $UGII_PACKAGE_DIRECTORY\ugii_package_env.dat
  ```
Enabling context sensitive help in local languages for customer defaults and KF

When using localized language versions of the NX Help, to get context sensitive help to work for Customer Defaults or Knowledge Fusion you need to edit the following two environment variables to point to the localized help:

• UGII_CSHELP_DEFAULTS_DOCS
• UGII_CSHELP_FUSION_DOCS

For example, to enable context sensitive help for Japanese Customer Defaults help you would set:

UGII_CSHELP_DEFAULTS_DOCS=${UGII_UGDOC_BASE}/data_services/resources/nx/${UGII_MAJOR_VERSION}/nx_help/ja_JP/graphics/fileLibrary/nx/cust_defaults

Browser requirements

Browser and plug-in requirements

The NX suite of documentation (Help, What’s new Guide, and Release Notes) is provided in an HTML format that is displayed in your local Web browser.

The documentation requires a web server. You can install the Siemens PLM Documentation Server, which sets up a local web server on each workstation, or install the documentation into an existing company-wide server.

The latest versions of web browsers are recommended to comply with the latest browser security updates.

Windows browser support

• Internet Explorer
• Microsoft Edge
• Mozilla Firefox

• Google Chrome

**Downloading browsers**

These browsers are free and can be downloaded from the following Web sites:

- **Internet Explorer** and **Edge** — [http://www.microsoft.com](http://www.microsoft.com)
- **Firefox** — [http://www.mozilla.org](http://www.mozilla.org)
- **Chrome** — [http://www.google.com/chrome](http://www.google.com/chrome)

**Windows .chm files**

Some parts of the Help are delivered in Microsoft Compiled Help format (.chm). Windows security enhancements prohibit opening .chm Help files across a network, so you must install those files on your computer. If you install .chm Help files on a server, you cannot read the Help across the network.

**Adobe Flash Player required for videos**

To watch videos and simulations, you must have the Adobe Flash Player installed as a plug-in to your browser. You can download the Flash Player (free) at the [Adobe Flash Player site](http://get.adobe.com/flashplayer).

**Adobe Acrobat Reader**

Some portions of the Help may be delivered as PDF, which requires the Adobe Acrobat Reader. You can download the free reader from [http://get.adobe.com/reader/](http://get.adobe.com/reader/).
Browser caveats

Browser caveats for Firefox

- Mozilla recommends that you upgrade to the latest version of Firefox due to security issues surrounding Java. They do not recommend using older versions of Firefox. For more information, see http://support.mozilla.org/en-US/kb/latest-firefox-issues.

- The default behavior in Firefox 3.0.5 is for new pages to be opened in a new tab. This affects the behavior of the global search since new links will open in a tab instead of a new window. You can configure Firefox to open a new window instead of a new tab by selecting Tools→Options→Tabs.

- Typically, you install and launch the Help from the http:// protocol which is fully supported. However, if you want to launch from a UNC path (file://), Firefox has a default security setting that prevents the Help from launching correctly. To enable this, you need to change the value of the security.fileuri.strict_origin_policy preference:

1. In the address bar, type about:config.

2. In the Filter field, type security.fileuri. If the value of the security.fileuri.strict_origin_policy preference is set to TRUE, set the value to FALSE. Double-click on the value to toggle it.

3. Restart the browser.

- If you are trying to open a .chm file that you have accessed from a web server (not from a local install), you may not be able to open the file as it is blocked. To unblock, right-click on the file and choose Properties, then select the unblock option.

Browser caveats for Chrome

Typically, you install and launch the Help from the http:// protocol which is fully supported. However, if you installed with the file:// protocol, you have to run Help from the command line. To fix this, see http://code.google.com/p/chromium/issues/detail?id=39767.

Browser caveats for Internet Explorer

If you do not see a video in Internet Explorer, it may be a cache issue. Try clearing your cache, or using a different browser.

Browser caveats for Adobe Flash Player

The following is applicable for the Adobe Flash Player:

- Chrome blocks Flash.
• Firefox blocks Flash by default. However, you can manually enable the Flash plugin for the Windows 64 bit browser.

• Internet Explorer blocks Flash by default. However, you can manually enable the plugin.

• Microsoft Edge blocks Flash.

Licensing Caveats

General licensing caveats

License files and license server

The following are applicable to license files and the license server:

• Merging of license files is not supported.

Example:
You can not merge a pre-TC 2007 MP3 or pre-NX 5 license file, which uses the uglmmd license daemon, with a TC 2007 MP3, NX 5, or NX 6 license file, which uses the ugslmd daemon.

NX requires and tests for the latest version of the ugslmd vendor daemon. This vendor daemon is supplied with NX and must be installed and initiated prior to starting NX. If an older daemon is utilized, a generic NX License Error dialog box is displayed during start-up. In addition, the syslog will contain an error message that the daemon version is older than the client.

NX Borrowing is version specific

NX license borrowing is version specific due to dependencies within the third party licensing software used by Siemens PLM Software. To ensure that NX works on a borrowed license, you should always utilize the borrow tool supplied with that NX version. For example, a license borrowed using the NX 1847 borrowing tool will work for NX 1847 but cannot be used to run NX 12. In addition, you cannot borrow licenses for two NX versions simultaneously on the same workstation.
Licensing caveats for Windows

The following caveats are applicable to Windows platforms only.

License Option tool

The License Option tool should only be used to borrow NX licenses, even though it may display other licenses. The License Option tool does not filter features in the license file that are of an earlier version than NX, such as Teamcenter lifecycle visualization, so these licenses are displayed in the tool. If you try to borrow a license for an application other than NX, you get an error when you launch the non-NX application.
Licensing caveats for Linux

Additional software to support licensing

SuSE and Red Hat require the following to be installed:

- LSB 4.0
# Product compatibility - supported version combinations

## Teamcenter and NX

The following table lists the version combinations of Teamcenter, Active Workspace, and NX that are supported.

<table>
<thead>
<tr>
<th></th>
<th>NX 12.0.2</th>
<th>NX 1847 Series</th>
<th>NX 1872 Series</th>
<th>NX 1899 Series</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Teamcenter UA 10.1</strong></td>
<td></td>
<td>✔</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>TC 10.1.7</td>
<td>AW 3.3.1</td>
<td>AW 3.4</td>
<td></td>
</tr>
<tr>
<td><strong>Teamcenter UA 11.2</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>TC 11.3.0.1_a0_patch_5</td>
<td>AW 3.3.1</td>
<td>AW 3.4</td>
<td>AW 4.0.4</td>
</tr>
<tr>
<td><strong>Teamcenter UA 11.3</strong></td>
<td>✔</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>TC 11.4.0_patch_5</td>
<td>AW 3.3.1</td>
<td>AW 3.4</td>
<td>AW 4.1</td>
</tr>
<tr>
<td><strong>Teamcenter UA 11.4</strong></td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
</tbody>
</table>

### Note:
- TC is Teamcenter
- AW is Active Workspace
- The Teamcenter release that is compatible with NX is identified in the table. If no patch is specified in the table cell, then the base release is the minimum required.

If a patch is required, then the Teamcenter patch level specified in a table cell is the minimum required for that Teamcenter release. Later patch levels in that release are also applicable, unless otherwise specified. For example, TC 11.4.0_patch_5 is the minimum patch level in the Teamcenter 11.4.0 release, and also includes patch_6, patch_7 and so on, that is, TC 11.4.0_patch_5 or higher.

- The NX release identifies the minimum update in that series, where applicable. For example, the NX 1847 series specifies the NX 1851 update as the minimum.
<table>
<thead>
<tr>
<th>Teamcenter UA</th>
<th>TC 11.4.0_patch_5</th>
<th>TC 11.4.0_patch_15</th>
<th>TC 11.5.0_patch_10</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>✔️AW 4.0.4</td>
<td>✔️AW 4.0.4</td>
<td>✔️TC 11.5.0_patch_10</td>
</tr>
<tr>
<td></td>
<td>✔️AW 4.1</td>
<td>✔️AW 4.1</td>
<td>✔️AW 4.1</td>
</tr>
<tr>
<td></td>
<td>✔️AW 4.2</td>
<td>✔️AW 4.2</td>
<td>✔️AW 4.3</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Teamcenter UA</th>
<th>TC 11.5.0_patch_10</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>✔️TC 11.5.0_patch_10</td>
</tr>
<tr>
<td></td>
<td>✔️AW 4.0.4</td>
</tr>
<tr>
<td></td>
<td>✔️AW 4.1</td>
</tr>
<tr>
<td></td>
<td>✔️AW 4.2</td>
</tr>
<tr>
<td></td>
<td>✔️AW 4.3</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Teamcenter UA</th>
<th>TC 11.6.0_patch_4</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>✔️TC 11.6.0_patch_4</td>
</tr>
<tr>
<td></td>
<td>✔️AW 4.1</td>
</tr>
<tr>
<td></td>
<td>✔️AW 4.2</td>
</tr>
<tr>
<td></td>
<td>✔️AW 4.3</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Teamcenter UA</th>
<th>TC 11.6.0_patch_4</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>✔️TC 11.6.0_patch_4</td>
</tr>
<tr>
<td></td>
<td>✔️AW 4.1</td>
</tr>
<tr>
<td></td>
<td>✔️AW 4.2</td>
</tr>
<tr>
<td></td>
<td>✔️AW 4.3</td>
</tr>
<tr>
<td></td>
<td>NX 12</td>
</tr>
<tr>
<td>------------------</td>
<td>-------</td>
</tr>
<tr>
<td>Teamcenter UA 10.1</td>
<td>✔️</td>
</tr>
<tr>
<td></td>
<td>TC 10.1.7</td>
</tr>
<tr>
<td></td>
<td>AW 3.3.1</td>
</tr>
<tr>
<td>Teamcenter UA 11.2</td>
<td></td>
</tr>
<tr>
<td>Teamcenter UA 11.3</td>
<td>✔️</td>
</tr>
<tr>
<td></td>
<td>TC 11.3.0.1_a01_patch_1</td>
</tr>
<tr>
<td></td>
<td>AW 3.3.1</td>
</tr>
<tr>
<td>Teamcenter UA 11.4</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td>Teamcenter UA 11.5</td>
<td>✔️</td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Note:
For information on version compatibility for Teamcenter and Teamcenter lifecycle visualization, see the Teamcenter documentation.
NX compatibility with Spreadsheet

<table>
<thead>
<tr>
<th>NX version</th>
<th>Platform ▼</th>
<th>Spreadsheet Software version ▼</th>
<th>Operating System ▼</th>
<th>Operating System version ▼</th>
<th>Windows</th>
</tr>
</thead>
<tbody>
<tr>
<td>NX 1899</td>
<td>Windows</td>
<td>Windows 10 64-bit</td>
<td>10 Pro &amp; Enterprise</td>
<td>Certified &amp; supported</td>
<td>MS Excel 2016 (32-bit)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>MS Excel 2013 (32-bit)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>MS Excel 2010 (32-bit)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>MS Excel 2007 (32-bit)</td>
</tr>
</tbody>
</table>

Note:

- The 64-bit versions of Microsoft Excel are supported starting in NX 12. The 32-bit version of Excel is installed by default on the Windows 64-bit Operating Systems.

- Microsoft Starter Edition is not supported by NX due to lack of support for Add-in's, Macro's, Math and Equation Editing.

- If you open a part with Excel 2003 data or older and then save the spreadsheet, NX updates the data to Excel 2007 or later (to the Excel version currently running with NX).

- If you launch a spreadsheet command such as Spreadsheet or Part Family on a system having Excel 2003 or older version as the default spreadsheet application, NX displays an error message and does not proceed with the launched command.

NX support for the currently supported versions of Microsoft Office will be discontinued as per the following dates:

<table>
<thead>
<tr>
<th>Microsoft Office version</th>
<th>End of support</th>
</tr>
</thead>
<tbody>
<tr>
<td>2007</td>
<td>October 11, 2017</td>
</tr>
<tr>
<td>2010</td>
<td>October 13, 2020</td>
</tr>
<tr>
<td>2013</td>
<td>April 11, 2023</td>
</tr>
<tr>
<td>2016</td>
<td>October 14, 2025</td>
</tr>
</tbody>
</table>
## NX applications unsupported on specific platforms

The applications listed are not supported on the specified platforms.

<table>
<thead>
<tr>
<th>Application</th>
<th>Functionality</th>
<th>Platform not supported on:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tooling &amp; Fixture Design</td>
<td>NX EasyFill Analysis - Advanced</td>
<td>Linux</td>
</tr>
<tr>
<td>NX Translators &amp; Open Tools</td>
<td>NX Open Python Author</td>
<td>Linux</td>
</tr>
<tr>
<td>Electro-Mechanical Design</td>
<td>Mechatronics Concept Designer</td>
<td>Linux</td>
</tr>
<tr>
<td>Mechanical Design</td>
<td>NX Drafting</td>
<td>Linux</td>
</tr>
<tr>
<td>Mechanical Design</td>
<td>NX Additive Design with Convergent</td>
<td>Linux</td>
</tr>
<tr>
<td>Mechanical Design</td>
<td>NX Layout</td>
<td>Linux</td>
</tr>
<tr>
<td>NX Translators &amp; Open Tools</td>
<td>Content Migration Manager for SolidWorks</td>
<td>Linux</td>
</tr>
<tr>
<td>NX Translators &amp; Open Tools</td>
<td>CMM Drawing Repair Assistant</td>
<td>Linux</td>
</tr>
<tr>
<td>Electro-Mechanical Design</td>
<td>ELMA</td>
<td>Linux</td>
</tr>
<tr>
<td>Electro-Mechanical Design</td>
<td>NX Piping Fabrication Drawings &amp; PMI</td>
<td>Linux</td>
</tr>
<tr>
<td>Mechanical Design</td>
<td>NX Lattice Structures Design</td>
<td>Linux</td>
</tr>
<tr>
<td>Mechanical Design</td>
<td>NX Ship Structure PMI Creation</td>
<td>Linux</td>
</tr>
<tr>
<td>Mechanical Design</td>
<td>NX Ship Dimensions &amp; Adv Annotation</td>
<td>Linux</td>
</tr>
<tr>
<td>Mechanical Design</td>
<td>Drawing Automation for NX (version 10 and later)</td>
<td>Linux</td>
</tr>
<tr>
<td>Mechanical Design</td>
<td>Layout for NX</td>
<td>Linux</td>
</tr>
<tr>
<td>Mechanical Design</td>
<td>NX Aerospace Design</td>
<td>Linux</td>
</tr>
<tr>
<td>Mechanical Design</td>
<td>NX Lattice Structures Design</td>
<td>Linux</td>
</tr>
<tr>
<td>Gateway</td>
<td>Advanced Studio Rendering Style Mode</td>
<td>Linux</td>
</tr>
<tr>
<td>Pre/Post</td>
<td>Abaqus OBD result file reading</td>
<td>Linux</td>
</tr>
<tr>
<td>Pre/Post</td>
<td>Topology Optimization and Shape Optimization</td>
<td>Linux Redhat</td>
</tr>
<tr>
<td>Motion</td>
<td>Motion Mechatronics co-simulation</td>
<td>Linux</td>
</tr>
</tbody>
</table>
Support for touch enabled devices

In NX 1899, you can interact and manipulate 3D models and control the overall user interface using touch screen and stylus. The support for touch enabled hardware follows a slightly different support model than what is provided through the NX certification program. We have tested NX on a number of Windows based touch screen laptops, monitors, and tablets. However, support for these devices and other comparable systems is limited as they are not true workstations and do not qualify for our full certification program. Support for these devices is limited as follows:

- Graphics performance issues are not supported as most of these devices do not offer the level of driver support available on workstations.

- Graphics quality and display issues are not supported unless they can be duplicated on a certified workstation.

- Any issue determined to be caused by the graphics driver is not supported.

- Performance issues with NX are not supported on these systems unless reproducible on certified workstations.

Caveats aside, we have tested and used for development a variety of touch based systems from HP, Dell, Microsoft, and others and have found them acceptable for general usage of NX.

Additional Notes

- NX supports touch devices on the Windows operating system.

- Only stylus configurations support pre-highlighting. The most commonly used devices supporting stylus are the Surface Pros.
2. NX Caveats and Product Notes

Teamcenter Integration for NX

Product Notes

Refile utility to be retired

Historically, the NX product release has included the refile utility, which was created many years ago for very specific data conditions and was never intended to be run by all customers on all of their data. This utility was never mandatory when performing NX upgrades.

NX product enhancements and improvements that are delivered and available in the current NX release make NX upgrades much faster and easier, so the refile utility is now obsolete. As a result, the refile utility is retired starting in NX 12.0.1. The documentation for the utility has already been removed in NX 12.

In place of the refile utility, standalone utilities will be introduced that incorporate non-version-up related options and future NX batch processes.

Specify ECN type when creating new ECN

If ECN types are defined in Teamcenter, when you create a new ECN in NX you can specify the ECN type in the Create Change dialog box.

Note:

- NX does not support multifield key (MFK) enabled change notice types.
- This functionality is applicable for Active Workspace 4.3.
Caveats

Listing order for JT assemblies in Assembly Navigator

The listing order of items you have set in the Assembly Navigator is not maintained for JT assemblies if you reopen the assembly. To get the set listing order for the JT assemblies, you need to save the top JT assembly with the master dataset.

Assembly arrangements in Active Workspace

NX does not load the assembly arrangement from Active Workspace. The arrangement that was active at the last save of the assembly into Teamcenter is loaded into NX.

Fundamentals

Product Notes

NX Virtual Reality display environment

The NX VR environment operates within the following display framework:

- The color of geometry comes from the NX component or object color (Edit Object Display → General tab, Basic group → Color). Color does not come from the True Shading material, Studio material, face, or facet color.

- Only solid-body, facet-body, and sheet geometry is displayed in the VR environment.

- The VR environment does not support translucency in the display.

- Geometry tessellation quality follows NX graphics window tessellation quality.

The following NVIDIA VR system is supported for NX Virtual Reality:


Unit Manager settings

When you run the ug_convert_part tool to convert an NX 12 part from mm to inch, the settings in the Unit Manager dialog box do not display the converted units. This is as intended.

The Units Manager dialog box displays the units that you have selected as the default units for data entry and object information output. Those units are independent of the underlying part units (metric or inch).
Cursor speed and shake gesture

Pressing MB1 and shaking the mouse from side to side is a new gesture called UGUI_MOUSE_SHAKE. This new gesture is reported to GIT clients whenever a user shakes the mouse.

An API is implemented to provide the value of the pointer speed at a given mouse movement gesture. This data is only valid if the current gesture is UGUI_PRE_POSITION or UGUI_DRAG_POSITION.

Navigate tool is retired

The Navigate tool is retired. You can explore your design in 3D space using Fly-through.
Caveats

NX Virtual Reality and Windows Mixed Reality

Windows update version 1809 creates multiple issues with NX VR and Windows Mixed Reality, including drops in frame rate. We recommend that you update Windows to version 1803 or 1903 and later.

Bookmarks

If you create a bookmark file with Ray Traced Studio mode enabled, when the bookmark is applied Ray Traced Studio mode is not in effect.

If you create a bookmark file when displaying a View Section with clipping disabled, when the bookmark is applied the section may be incorrectly clipped.

If you try to apply a bookmark file when

1. the bookmark file is not for the current displayed part and
2. the number of views in the layout at the time when the bookmark file was created is not the same as the number of views in the current displayed part

then the number of views in the layout may be wrong after the bookmark file is applied. Applying the same bookmark file a second time corrects the number of views.

Customer Defaults

Customer defaults

Customer defaults allow you to customize the operation of NX. The initial settings and parameters of many functions and dialog boxes are controlled by customer defaults. You can view them by choosing File→Utilities→Customer Defaults.

For a description of the new or modified customer defaults, see Customer Defaults for NX 1899.

For additional information on customer defaults, see System administration→Customizing the NX installation→Customer Defaults in the NX online help. For a listing and description of all customer defaults, see Fundamentals→Customer Defaults in the NX online help.
Design (CAD)

Modeling

Product Notes

Commands being retired in NX 1899

The following commands have been replaced by newer functionality and are no longer readily available in 1899.

- **Join Curve** – now use the **Composite Curve->Join Curves = Yes** option.
- **Fillet Sheet** - now use **Face Blend**.

These retired commands are controlled by environment variables and the **Command Finder** will not list them. If you need access to the commands, please contact GTAC.

Editing Lattice commands

Because a Lattice feature is a mesh body that can be comprised by many facets, there may be variations at the facet levels of the lattice body during edit.

Lattice rod diameter fields

Documentation is added regarding a Lattice Rod Diameter using a Field. The software will be updated to support this in the future.

Assemblies

Caveats

Minimal loading of JT files

You cannot minimally load a monolithic JT file in native NX, only in Teamcenter Integration for NX.

Mirror Assembly

When you move a mirror plane while both the **Mirror the absolute origin location of all mirrored assemblies or components** option and the **Associative Mirror** option are set, the location of the mirrored assembly or components updates, but the mirrored absolute origin does not update.
Minimally Load - Lightweight Display

The following caveats apply when you load assemblies using the Minimally Load - Lightweight Display option:

- If you use this load option to load assemblies that have the following characteristics, the components will be loaded partially instead of minimally:
  - Pre-NX 9 components
  - Geometry overrides
  - Assembly-level facets

- The associativity between multi-CAD override geometry and NX objects, such as PMI, will not be maintained when assemblies are loaded using the Minimally Load – Lightweight Display assembly load option.

Component patterns

When the setting of your Move Component Scope customer default is Anywhere in Assembly, NX ignores this setting if the active window's root part or any of its subassemblies contain any component patterns. When you move components in this situation, the Move Component command behaves as though the Move Component Scope customer default is set to Work Part Only.

When a subassembly of the active window's root part contains a component pattern, inserting a motion step in your sequence that affects a member of the component pattern may cause incorrect movement of the following:

- Members of the component pattern.
- Components directly constrained to the pattern members.
- Components indirectly constrained to the pattern members.

Note:
When component patterns are present only in the active window's root part, the Insert Motion command works correctly.

Reflect Component

You can’t:

- Create a component pattern for reflected components.
- Export reflected components using the Export VRML command.
• Use NX 12.0.2 assemblies that contain reflected components in NX 12 or NX 12.0.1 because they don't support reflected components.

Reflected components are limited or aren't supported in some applications and tools:

**CAM**
CAM doesn't support assemblies with reflected components. Although you can perform programming on reflected components, the results may be unpredictable.

**PTS**
Product Template Studio (PTS) templates don't support moving reflected components.

**Motion**
You can't start the Motion application if your assembly contains any reflected components.

**Simcenter 3D Pre/Post**
If you start the Simcenter 3D 3D Pre/Post application, all reflected components are removed from your assembly.

**Fixture Planner and Line Designer**
For Fixture Planner and Line Designer, we recommend disabling assembly reflection for the following reasons:

- We believe that it doesn't make sense to use reflected components for any equipment in the plant structure or Bill of Equipment, because such equipment isn't purchasable. For example, robots or conveyors aren't available in reflected versions.

- Downstream applications like Process Simulate don't support reflected components in the plant structure.

- For Fixture Planner, reflected assemblies in the product structure aren't supported because features like weld points and locators must have unique identifiers for left-hand and right-hand parts. Features and locators must also be associated to either a right-hand part or a left-hand part.

### Drafting

#### Caveats

**Out of date drawing status for minimally loaded components**

When you load a multi-CAD assembly drawing using the **Minimally Load - Lightweight Display** option, your drawing may appear out of date if the following conditions apply.

- If the **Default Unit** customer default is set to a unit (for example, MM) that is different than the part unit of the JT part in the multi-CAD assembly (for example, INCHES), then the drawing will always appear out of date when it is first opened.

- If your multi-CAD assembly drawing contains one or more of the following object types, it may appear out of date when it is first opened.
• Inherited PMI region.
• Imported PMI section view.
• Hole table.
• Detail view.

Product Notes

Workflow enhancements

To improve your workflow efficiency, the following usability enhancements are introduced:

• The Base View command is now the default command that is presented when you create a new drawing or add a new sheet. If you prefer to use the View Creation Wizard instead, set the Always Start customer default to View Creation Wizard.

• It is easier to locate the correct command for creating a hole callout and thread callout from the Command Finder.

Commands to be retired in a future release of NX

The following commands will be retired in a future release of NX and are now hidden so that Command Finder will no longer list them

• Edit→Annotation→Edit Text

The command is under an environment variable and the Command Finder will not list it. If you need access to the command, please contact GTAC.

Layout

Product Notes

Create from 3D

When you use the Create from 3D command, you can now select lightweight components without first setting the Load Smart Lightweight Data customer default. Assembly performance improvements made that default obsolete in NX 12.0. Now smart lightweight data is loaded whenever NX needs it to complete an action.
Product and Manufacturing Information (PMI)

Product Notes

STEP support in published PMI Technical Data Packages

The PublishTDP batch program lets you generate a STEP file and attach it to the Technical Data Package output from a command line prompt. Only STEP AP242 is supported, and you must have the appropriate STEP license in order to generate the STEP file.

Routing

Product Notes

NX-Capital products version compatibility

For Capital:

<table>
<thead>
<tr>
<th>Capital</th>
<th>NX11</th>
<th>NX12</th>
<th>NX1847</th>
<th>NX1872</th>
<th>NX1899</th>
</tr>
</thead>
<tbody>
<tr>
<td>2017.1</td>
<td>Connect Mode + 2D Harness View</td>
<td>Connect Mode + 2D Harness View</td>
<td>Connect Mode + 2D Harness View</td>
<td>Connect Mode + 2D Harness View</td>
<td>Connect Mode + 2D Harness View</td>
</tr>
<tr>
<td>2018.1</td>
<td>Connect Mode + 2D Harness View</td>
<td>Connect Mode + 2D Harness View</td>
<td>Connect Mode + 2D Harness View</td>
<td>Connect Mode + 2D Harness View</td>
<td>Connect Mode + 2D Harness View</td>
</tr>
<tr>
<td>2019.1</td>
<td>Connect Mode + 2D Harness View</td>
<td>Connect Mode + 2D Harness View</td>
<td>Connect Mode + 2D Harness View</td>
<td>Connect Mode + 2D Harness View + Direct Integration</td>
<td>Connect Mode + 2D Harness View + Back shell clocking</td>
</tr>
</tbody>
</table>

For VeSys:

<table>
<thead>
<tr>
<th>VeSys</th>
<th>NX11</th>
<th>NX12</th>
<th>NX1847</th>
<th>NX1872</th>
<th>NX1899</th>
</tr>
</thead>
<tbody>
<tr>
<td>2018.1SP1904 onwards</td>
<td>Connect Mode +</td>
<td>Connect Mode +</td>
<td>Connect Mode +</td>
<td>Connect Mode +</td>
<td>Connect Mode +</td>
</tr>
</tbody>
</table>
Sheet Metal

Caveats

Patterning of a gusset on non-cylindrical bends

When a gusset is on a non-cylindrical bend, you cannot create a pattern of the gusset.

Note:
This is applicable only for gussets created using Automatic Profile.

To create a pattern of a gusset that exists on a non-cylindrical bend:

1. Extract the curve of the mold edge of the non-cylindrical bend. For example, use Offset Curve in Face to extract the curve.

2. Use the extracted curve for defining the plane location and create a gusset.

3. Pattern the gusset using the extracted curve as a path.

   Tip:
   To do this, use Along in the Layout list.

Bridge Bend

You cannot create a bridge bend if the two sheet metal bodies intersect in the following way:

- A body from which you select an end edge intersects with the non-planar web face of the parent body of start edge.
Convert to sheet metal

If you create a fold transition between the planar web faces of chained bends and convert the body to a sheet metal part, the conversion may be partially successful.

Exporting multi-segment lofted flanges to Trumpf GEO format

Flat Pattern of a model that contains multi-segment lofted flanges cannot be exported to Trumpf GEO format.

Creating multiple flanges

While creating multiple flanges, if adjacent flange edges are not in the same set, you cannot apply an internal miter.

Unite in Sheet Metal

If you unite bodies that consist of Sheet Metal and advanced Sheet Metal features, the united body may not support subsequent Sheet Metal operations.

Material and Bend tables

The tool selection options are not available for the following commands and options.

- Hem Flange
- Lofted Flange
- Convert to Sheet Metal
- Bridge Bend→Type group→Z or U Transition
  Bridge Bend→Type group→Fold Transition→Bend Properties group→Define By list→Length option
Human Modeling

Product Notes

Predict posture algorithm updates for class A vehicles

In this release, the posture prediction algorithms for Class A vehicles are updated. The new models from the University of Michigan Transportation Research Institute (UMTRI) now also consider the age and gender of the occupant.

Documentation Notes

Hands-on learning aids in the online help

The online help now includes a limited number of hands-on procedures with part files to download, which let you work through detailed instructions on your own. These hands-on procedures are a good learning tool to try out new functionality and complex workflows. The procedure topics are titled Hands-on: <Procedure name>.

PCB Exchange

Caveats

Flat Solid workflow

The import and export of ECAD models in their bend state only works when the board is a solid body. If the board is an assembly component this workflow does not work.

Manufacturing (CAM)

Manufacturing Product Notes

Manufacturing Product Notes

The Manufacturing product notes describe product changes that are not included in the What’s New in NX documentation.

CAM Early Validation Program

Access to some early NX CAM functionality is controlled by feature toggles (File→Utilities→Feature Toggles).
• Feature-based machining: Refactored **Machining Feature Navigator**
  This feature improves performance and offers configuration and filtering capabilities.

• Additive Manufacturing: Grouping parts in the build tray
  This feature lets you organize parts in the build tray so that you can manage the group as an individual object.

• Turning: Automatic Feed Rate Computation in Turning
  This feature supports automatic feed rate calculation from chip thickness in turning operations.

• Turning: Optimized Cut Patterns in Turning
  This feature creates a smooth tool path in Turn Roughing Operations for faster machining and extended tool life.

• Turning: Optimized Cut Patterns with Minimum Radius Support in Turning
  This feature creates smooth tool paths in Turn Roughing Operations with minimal remaining material in corners.
  You must request a key file to access this feature. GTAC will forward your request to the appropriate development contact.

**Tool path and template changes**

**Tool path changes**

A general reminder: There are ongoing changes in the processors to fix problems, add enhancements, and improve reliability. In many cases, you may see some differences between the new path and the old path when you generate an operation from a previous release. If you rely on automatic methods, these changes should be acceptable. The end result of the new path should be comparable to, or better than, the previous path.

To prevent accidental changes to tool paths in part files from a previous release, use the **Lock Tool Paths During Version Upgrade** customer default. This option automatically locks all operations with an edit status of **Complete** or **Repost**.

**Ongoing changes**

Multiple dialog boxes are changing to the explorer tree format.

**CAM configuration changes**

• **dbc_tool_ascii.def**
  Changed the alias **Diameter1** to alias **Diameter** in RSET of STEP_DRILL.

**Operation template sets**

• No changes
Operation templates

Changes apply to English and metric template parts.

Operations in the following template parts are now in the explorer format.

- hole_making
- mill_planar.prt
- mill_contour.prt
- mill_multi-axis.prt
- mill_multi_blade.prt
- mill_rotary.prt
- turning.prt
- multi_axis_deposition.prt

Operations in the legacy non-explorer format are in the following template parts, which are located in the mach\backups\template_part\english or the mach\resource\template_part\metric folder.

- hole_making
- mill_planar.prt
- mill_contour.prt
- mill_multi-axis.prt
- mill_multi_blade.prt
- mill_rotary.prt
- turning.prt
- multi_axis_deposition.prt

The mill_planar.prt template has additional changes.

- Added the new dedicated FLOOR_WALL subtypes: CHAMFERING_MODELED, FLOOR_FACING, POCKETING, WALL_FLOOR_PROFILING, and WALL_PROFILING.
• Deleted the legacy operations: FLOOR_WALL_IPW, FACE_MILLING_AREA, FACE_MILLING, FACE_MILLING_MANUAL, ROUGH_FOLLOW, ROUGH_ZIGZAG, ROUGH_ZIG, CLEANUP_CORNERS, FINISH_WALLS, FINISH_FLOOR, and MILL_USER.

• Renamed PLANAR_PROFILE to PLANAR_PROFILING.

The hole_making template has additional changes.

• Added the new BORING_REAMING, COUNTERBORING, and SPOT_FACING operations.

• The Create Feature Process dialog box does not contain Process Type examples.

The following template parts are new in Turning:

• turning_VTL.prt
  Includes vertical turning operations.

• centerline.prt
  Includes centerline drilling, reaming, and tapping operations.

Note:
To see the new templates, you may need to manually add them to the Type list in the Create Operation dialog box. Choose Browse, and then navigate to the mach\resource\template_part \english folder or the mach\resource\template_partmetric folder.

Setup templates for Turning

There are three new setup templates available when you choose File→New→Manufacturing.

• Prismatic Milling and Hole making

• Prismatic Turning and MillTurn

• Prismatic Vertical Turning and MillTurn.

Customized templates

If you create your own template files, you must back up the files before you upgrade to the current release. Copy the template files from the templates folder (%UGII_CAM_BASE_DIR%\mach \templates\) to a separate location to prevent the installation from overriding your defined templates.

After the upgrade installation is done, copy your template files to the %UGII_CAM_BASE_DIR%\mach \templates location.
Merging customized templates

You can merge your customized templates with the templates included in this release in the following ways:

- Start with the new default templates and apply your customizations. This is highly recommended to ensure you receive all the PR fixes.

- Re-file your customized templates in the new release, review the changes listed for the release, and implement the applicable ones in your templates. This method is not recommended, because you will not receive the PR fixes.

General changes

Changes to the tool path display

In the Ribbon bar, Select Tool Path is replaced by Display Tool Path.

- Display Tool Path lets you turn the tool path display on or off.

- When the tool path is displayed, the selection filter is set to Tool Path, which lets you select any point along the tool path for machining analysis.

- You can now turn the tool path display on or off when you display the IPW or animate the tool path.

Machine Tool changes

The standard machine tools supplied with NX have revised postprocessors and kinematics models. Review all existing Manufacturing setups which use a standard machine tool from a release prior to NX 8. If necessary, retrieve the machine tool again.

Milling

Floor Wall operations

Releases previous to NX 12.0.1 used a negative stock value to define an additional depth for through holes.

If you used a negative floor stock value instead of the current Z-Depth Offset value to define an additional depth for through holes, and want to maintain the settings, set the following variable:

```
UGII_CAM_FW_INFER_FLOORS_NEG_STOCK =1
```
Adaptive Milling operations

Bull nose mills are now fully supported. You can use any kind of bull nose tool in Adaptive Milling operations.

Integrated Simulation and Verification (ISV)

ISV Simulation

- Support for VNCK 4.8.2 is added, and support for VNCK 2.6 is removed. VNCK 4.8.2 is officially released for Windows 10.

- External file simulation in Teamcenter Integration for NX uses the same file selection box as native NX.

- The MachineConfigurator version 1.0.0.1027, and future versions, support the definition of valid file extensions. We recommend that you use the latest version of the MachineConfigurator, because future CCF files shipped with NX will include such file extension definitions. With NX1872, the new MachineConfigurator version 1.0.0.1220 includes the following:
  
  - Updated CSE documentation
  - Bug fixes
  - Support for selecting robot controllers
  - Support for VNCK 4.8

- The latest CCF files for the TNC and Fanuc controllers require the Python controller parser type. When you set Implementation to Python, it is no longer necessary to redefine global variables inside the driver. The driver now obtains the variables directly from the kinematics model.

  Note:

  If you prefer the library parser approach, use the CCF files from NX 11. You must define global variables inside the driver for this approach.

ISV using CSE simulated controllers with Python parser

- The CSE Python parser is supported for Windows only. This means that the standard examples supplied with NX will not run on non-Windows operating systems. As a workaround: Inside the Machine Configurator, in the Global Settings dialog box, change the Implementation setting for the MCF from Python to Library.

- For existing simulations using Python parser with encrypted files from older versions, for example NX 9 or NX 10, we recommend that you use the un-encrypted *.py files from the latest release.
Feature-based Machining (FBM)

Machining Feature Navigator

The Details panel of the Machining Feature Navigator is now hidden by default.

Right-click in the background of the Machining Feature Navigator and choose Show Details Panel to turn the Details panel display on for more information, or off for faster performance.

Machining Knowledge Editor (MKE)

If you migrate your machining knowledge file to NX 1899, you may need to make changes using the MKE. The MKE command File→Check validity may report errors due to improvements made in the underlying base customization.

Changes from pre-NX 1899 to NX 1899 in the machining knowledge base customization

For operations subtypes derived from the class ThreadMilling:

- Stepover_Variable_Max is replaced by Stepover_Variable_Max_Min[1]
- Stepover_Variable_Min is replaced by Stepover_Variable_Max_Min[2]

For operation subtypes derived from class VolumeBased25DMilling:

- Stepover_Number_of_Passes is replaced by Step_Points[3]

Hole machining

Output changes

Drilling operations now output both CLEAR and RAPTO parameters when a separate RAPTO value is specified.

Example:

Top Offset = 3
Rapto Offset = 1

Cycle output for previous releases:

    CYCLE/DRILL, RAPTO, 3.0000, FEDTO, -36.7060, RTRCTO, AUTO, MMPM, 250.0000

Cycle output for NX 1899:
If a separate Rapto Offset value is not specified, the CYCLE statement includes only the CLEAR parameter.

Hole milling cycle output change

Hole milling operations now output the CLEAR parameter instead of the RAPTO parameter.

<table>
<thead>
<tr>
<th>Hole milling output in NX 1884</th>
</tr>
</thead>
<tbody>
<tr>
<td>CYCLE/</td>
</tr>
<tr>
<td>MILL,HOLE,HELICAL,RAPTO,0.0000,FEDTO,-0.6586,RTRCTO,0.0000,IPM,10.0000</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Hole milling output in NX 1899</th>
</tr>
</thead>
<tbody>
<tr>
<td>CYCLE/</td>
</tr>
<tr>
<td>MILL,HOLE,HELICAL,CLEAR,0.0000,FEDTO,-0.6586,RTRCTO,0.0000,IPM,10.0000</td>
</tr>
</tbody>
</table>

Thread milling cycle output change

Thread milling operations now output the CLEAR parameter instead of the RAPTO parameter.

<table>
<thead>
<tr>
<th>Thread milling output in NX 1884</th>
</tr>
</thead>
<tbody>
<tr>
<td>CYCLE/</td>
</tr>
<tr>
<td>MILL,HOLE,THREAD,RAPTO,0.0000,FEDTO,-10.0000,RTRCTO,0.0000,MMPM,250.0000</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Thread milling output in NX 1899</th>
</tr>
</thead>
<tbody>
<tr>
<td>CYCLE/</td>
</tr>
<tr>
<td>MILL,HOLE,THREAD,CLEAR,0.0000,FEDTO,-10.0000,RTRCTO,0.0000,MMPM,250.0000</td>
</tr>
</tbody>
</table>

Post

Library posts installed with NX

The Post Builder postprocessors are removed from the standard library machine tools, simxx, delivered with NX. If an existing CAM setup refers to a library entry that used the Post Builder posts, it will not work. You must do one of the following:
• Replace the machine tool with a library entry that uses the Post Configurator post.

• Copy the post from NX 12.0.2, and add it to the current NX library.

Post Configurator and TCL

As of NX 12.0.1 MP1, the NX CAM tcl version is upgraded from TCL version 8.4 to version 8.6. You may need to update your company’s tcl files because TCL version 8.6 has a stricter grammar check.

We recommend that you always edit the Post Configurator postprocessor tcl files in the Post Configurator tcl editor. If you use your own text editor, set the encoding to UTF-8 without BOM.

Machining Line Planner

• MLP can now be used with Teamcenter Integration for evaluation purposes. The basic commands are available.

• The new Allocate One command lets you automatically allocate multiple operations to a setup, thereby minimizing tool changes and table rotations.

• Column configuration sets can be defined for the Processes, Products, Resources, Operations Sets, and Sequence Constraints panels.

• Exact machining times can be calculated using the new NX CAM command Calculate Machining Times.

Manufacturing critical maintenance and retirement notices

Planned retirement of operations from all platforms

The following operations are hidden by default, and will be removed in NX 1926. These operations are available in the mill_planar_nonExplorer_Style.prt template, which is located in the mach/backups/template_part folder.

• rough_follow, rough_zigzag, rough_zig

• VolumeBased25DMilling: floor_wall_ipw

• PocketMilling: cleanup_corners, finish_walls, finish_floor

• FaceMilling: face_milling

Planned retirement of Create Feature Process type Template Based

In the Create Feature Process dialog box, the Template Based option will be retired in NX 1953.
Retirement of legacy options

In the Area Milling drive method, the steep containments options Directional Steep and None are no longer supported, and are removed in the current release.

The following options are no longer supported, and were removed in the previous release.

- The Trochoidal cut pattern option.

  Note:
  The Adaptive Milling operation should be used instead of the Trochoidal cut pattern.

- The radial, concentric, and Standard Drive cut patterns for the Area Milling drive method.

- The On Plane stepover option for the Area Milling drive method.

- The Spiral, Boundary, and Radial Cut drive methods for fixed-axis contouring operations.

  Note:
  When these drive methods are used in an existing operation, NX continues to display them in the Drive Method list, and to generate the operation.

- The Use 2D workpiece option for Area Milling, Flow Cut, and Zlevel operations.

- The Blank distance option for Cavity Milling operations.

Manufacturing Wizard Builder

The Manufacturing Wizard Builder is on critical maintenance. It is a plug-in for the Process Studio Author (PSTUDIO) application, which is no longer being developed. The 32 bit version is included in the NX installation, and there is no plan to discontinue this.

The location in the Windows start menu has changed. Choose Start→All Programs→Siemens NX→Manufacturing→Process Studio Author

There are no plans to discontinue CAM Wizards, which are xml files based on our block based UI architecture.

Point To Point planned retirement from all platforms

Point To Point is in critical maintenance. The Drill template has been hidden by default, but is still available.
Manufacturing documentation notes

Hands-on learning aids in the online help

The online help now includes a limited number of hands-on procedures with part files to download, which let you work through detailed instructions on your own. These hands-on procedures are a good learning tool to try out new functionality and complex workflows. The procedure topics are titled Hands-on: <Procedure name>.

Note:
Make sure you are not in the Welcome role when you work through a hands-on procedure.

Manufacturing caveats

General caveats

Machining Feature Navigator

The Machining Feature Navigator is sometimes empty for parts loaded in the Manufacturing Compare Tool Navigator. As a workaround, right-click a column header in the Machining Feature Navigator, and choose Apply Filter. This problem will be fixed in a future release.

Software updates in Customer Defaults

As of NX 1847, NX does not use these customer defaults: Use Latest Updated Templates and Use Latest Updated Libraries.

Reflect Component

NX CAM does not support the Reflect Component assembly command. If you use any geometry from a reflected component for your operation, the results may be unpredictable.

NX CAM plans to support the Reflect Component command in a future release.

NX process

When you exit NX, it may close the UI without stopping the process. There is no data on how widespread this problem is.
Tilt Tool Axis

<table>
<thead>
<tr>
<th>Problem</th>
<th>Workaround</th>
</tr>
</thead>
<tbody>
<tr>
<td>Shortest 2D distance to curve</td>
<td>Use the 3D shortest distance option.</td>
</tr>
<tr>
<td>For longer tool paths, the shortest distance calculation can become</td>
<td></td>
</tr>
<tr>
<td>unsynchronized.</td>
<td></td>
</tr>
<tr>
<td>The tilted tool path may have non cutting moves with lifts in regions</td>
<td>None</td>
</tr>
<tr>
<td>where they are not needed, and the moves can cause gouges.</td>
<td></td>
</tr>
</tbody>
</table>

**IPW**

- A **Generic Motion** (GMC) operation does not change the machine mode state of the IPW. Adding a **Machine Control** subop with a **Set Modes** event at the beginning of the GMC operation does not change the machine mode state of the IPW. The previous machine mode, either milling or turning, remains active.
  
  If the preceding operation does not have the required machine mode, you must add an operation with the required machine mode before the **Generic Motion** operation. For example, if the Generic Motion operation is for turning, add a turning operation. The new operation must generate tool path, but does not need to cut material.

  **Note:**
  
  This is not a limitation in ISV when you use the CSE driver. The machine state is defined by the workpiece spindle setting, which is either turning or milling.

**Milling caveats**

**Rotary Floor milling**

<table>
<thead>
<tr>
<th>Problem</th>
<th>Workaround</th>
</tr>
</thead>
<tbody>
<tr>
<td>The <strong>Min. Lead Angle</strong> does not influence the tool path.</td>
<td>None</td>
</tr>
</tbody>
</table>

**Multi Axis Roughing**

<table>
<thead>
<tr>
<th>Problem</th>
<th>Workaround</th>
</tr>
</thead>
<tbody>
<tr>
<td>The <strong>Custom Feed and Speed</strong> parameter values specified for the <strong>Helical</strong> and <strong>Plunge</strong> engage types are not output in the G code. The engage motions use the specified <strong>Cut</strong> feed rate.</td>
<td>To control the engage feed rate during the helical or plunge move, do the following:</td>
</tr>
<tr>
<td></td>
<td>1. Select the <strong>Feeds &amp; Speeds</strong> node.</td>
</tr>
<tr>
<td></td>
<td>2. In the <strong>Feed Rates</strong> group, under <strong>More</strong>, define an <strong>Engage</strong> feed rate.</td>
</tr>
</tbody>
</table>
Hole machining caveats

Tapping operations

Drilling and Tapping are distinct operation subtypes. Although tapping cycles are available in the Drilling operation dialog box, we recommend that you do not use a Drilling operation combined with a tapping cycle. The tapping cycles will be removed from the Drilling operation in a future release.

In a Tapping operation, you can set feature geometry parameters, such as pitch, that output the required mom variables for tapping. If you use one of the tapping cycles in a Drilling operation:

- The operation will not contain the necessary feature geometry parameters and in-process feature volumes for tapping.
- You will have the legacy Point to Point output where the pitch is driven by feed rate.

Back Counter Sinking operation

The Gouge Checking option reports false gouges.

ISV caveats

NCK Power On Reset

In the Human Machine Interface (HMI), if you execute an NCK Power On Reset (warm restart) while the simulation is stopped for any reason, the VNCK state and the simulation state in NX are not the same.

If you try to continue the simulation, or execute an NCReset, NCStop, or NCStart command, NX displays the following Machine Tool Simulation message and aborts the action.

VNCK executed an externally triggered 'NCK Power On Reset (warm restart)' while being in 'SIM Stop' mode. This is an unsupported use case which created an inconsistent state. Shutdown and reboot VNCK to heal this.

If this happens you must shut down and reboot the VNCK.

Synchronization Manager

In Windows 10, if you choose File→Exit to terminate the NX session, and the Synchronization Manager dialog box is open, NX displays Parasolid error messages before terminating the NX session.
Visualize 2D Dynamic

- If blank geometry is not defined, you must click Step Forward twice before NX asks for blank geometry.

- The 8-bit PseudoColor visual graphics driver mode is not supported. As a work around, change the graphics X server settings. For example:
  
  Nvidia Quadro and FX graphics drivers
  
  In the XF86Config file, in the Device section, set CIOverlay to TRUE.

Simulation

- In certain cases the reported minimum distance of a clearance violation is not the closest distance.

- Selecting a location on the tool path is now supported in ISV for both CSE-based simulation and tool path simulation. Selecting tool path segments involving cycles, such as drilling cycles, may not work in some cases. There are also some cases in which the selected positions of rapid motions are not displayed correctly.

- When the simulation runs in the history buffer, and the spindle speed **Output Mode** for an operation is set to SFM or SMM to maintain constant surface speed, the simulation behavior can be unreliable.

- When you use the **Machine Code Based Simulation** option for synchronized operations, **Show Tool Path** is supported, but **Path Segment Selection** is not supported.

- When you use the **Machine Code Based Simulation** option in the sim09 machine tool, milling operations using CYCLE800 may have unwanted 360-degree motions of the C-axis.

- When you use the **External Program Simulation** option, and you replace a machine, the software removes the selected external main program from the **Program Manager** dialog box. You then lose all changes in the edited main NC code program. As a workaround, save your main program before replacing the machine.

CSE simulation

- When there are multiple workpiece objects, the tool trace is always attached to the first component classified as _WORKPIECE_, and moves with the component. If the tool trace is displayed on the wrong component, you can reorder the kinematics tree to place the required _WORKPIECE_ component first. NX uses the tool tip of the active tracking point, of the active tool, in the carrier.

  - To set the active tracking point, use **SetCorrectionSwitch/SetToolCorrection**.

  - To set the active tool, use **activateNextTool**.

- When dragging behavior is used (Kv >0), the display and the collision checking are not synchronized.
The graphical display uses the dragged positions.

Collision checking and material removal are based on the ideal interpolated values.

This means that NX may report a collision that is not directly visible inside the graphics window.

**Virtual NC Kernel (VNCK)**

- When it reaches a breakpoint, the simulation may fail to stop or may not stop at the exact position specified.

- Although the supported VNCK versions (4.4, 4.5.2 and 4.7.4) are not officially released for Windows 10, they usually run without any problems when you use **HMI Operate**. If the VNCK does not boot after installing, please ensure that Windows Data Execution Prevention is not active for `vncksl.exe` and `vplc3172dp.exe`.

1. Press the Windows key.
2. In the search box, type **advanced system**, and press Enter.
3. In the **System Properties** dialog box, click the **Advanced** tab.
4. Under **Performance**, click **Settings**.
5. Click the **Data Execution Prevention** tab.

If the **Turn on DEP for all programs and services except those I select** option is selected, you must exclude the `vncksl.exe` and `vplc3172dp.exe` files.

To exclude the `vncksl.exe` and `vplc3172dp.exe` files:

1. Click **Add**.
2. Select the `vncksl.exe` and `vplc3172dp.exe` executable files.
   
   The default location for both files is the VNCK installation folder.
3. Click **OK**.

**Note:**

You must exclude the `vncksl.exe` and `vplc3172dp.exe` files for all installed VNCKs.
HMI Advanced

- HMI Advanced is always positioned in the top left corner of the Windows desktop. You cannot move it from there.
- HMI Advanced is always on top of all other applications.
- Starting HMI Advanced resets Windows colors to a specific HMI Advanced color schema.
- When you run HMI Advanced, you can’t use function keys, such as F1, for other programs. The function keys won’t work in the other programs until you exit HMI Advanced.

Additional restrictions:
- Windows 10 is not supported.

Positional ISV — Show Machine Axis Positions dialog box

When the setup has a multi-function machine and you use the dynamic manipulator to change the tool axis for a fixed-axis operation, NX does not update the Show Machine Axis Positions dialog box. To avoid confusion, use the Show Machine Axis Positions customer default to suppress the dialog box.

2. In the Customer Defaults dialog box, choose Manufacturing→User Interface.
3. Click the Dialog Boxes tab, and in the Visibility group, clear the Show Machine Axis Positions check box.

Generate IPW with Path customer default

Using the Generate IPW with Path customer default may cause commands that require the IPW, such as Verify, to have problems when the IPW is not complete. This can happen because the IPW takes more time to generate than the operation.

Post Configurator

Heidenhain TNC PLANE rotation on non-orthogonal 5axis machine

The Real Machine Axis option for tilting plane kinematics does not work with non-orthogonal 5-axis machines for Heidenhain TNC PLANE rotation. The SPA, SPB, SPC angles in the PLANE command output could be wrong.
DEF File Editor

The editor removes comments from the main definition file, including any existing comments.

TCPM prepositioning plane

When this option is activated, the plane output for the prepositioning is wrong in the following case:

- There is only one MCS in the Geometry View of the Operation Navigator, and
- The MCS is defined as Local, and
- Special Output is set to None.

Machining Line Planner

Assembly Load Options

The default assembly load option is now Minimally Load - Lightweight Display, which does not work correctly for Machining Line Planner.

Use one of the partially load or fully load options.

Feature based machining caveats

Teach Feature Mapping, Teach Operation Sets

Limitations and workarounds:

<table>
<thead>
<tr>
<th>When you</th>
<th>Teach Operation Sets does not use</th>
<th>Workaround</th>
</tr>
</thead>
<tbody>
<tr>
<td>Run Teamcenter Integration for NX, and store the operation templates in Teamcenter</td>
<td>The correct operation subtypes</td>
<td>• Manually add the missing tool classes and operation subtypes to the generated machining rules using the Machining Knowledge Editor.</td>
</tr>
<tr>
<td>Use a library other than the native ASCII library, such as MRL or TDM</td>
<td>The tool class</td>
<td>• Replace the missing subtypes and classes. To do this:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>1. (Optional) Change your CAM configuration to use native operation types</td>
</tr>
</tbody>
</table>
When you Teach Operation Sets does not use Workaround

and the standard ASCII tool library.

2. Use Teach Operation Sets to teach the operations.

3. Use the Machining Knowledge Editor to add or optionally replace the tool classes and the operation subtypes.

**Documentation caveats**

**What's new in NX 1899, Machining Line Planner**

*What's new in NX 1899→Manufacturing (CAM)→Machining Line Planner→MLP column configuration enhancements*

The *Where do I find it?* section should state that the **Configure Columns** command is available from the **Processes** or **Products** panel.

<table>
<thead>
<tr>
<th>Application</th>
<th>Machining Line Planner</th>
</tr>
</thead>
<tbody>
<tr>
<td>Prerequisite</td>
<td>The CAM setup and parts to machine must follow the master model structure recommended for CAM and MLP.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Machining Line Planner Navigator</th>
<th>Processes or Products panel→Configuration Sets→Configure Columns</th>
</tr>
</thead>
<tbody>
<tr>
<td>Processes or Products panel→Configure Columns</td>
<td></td>
</tr>
</tbody>
</table>

**Manufacturing Tutorials**

When you select a manufacturing tutorial, NX displays a **Save As** dialog box, and the part file does not launch.
Example:

In the Save As dialog box, NX displays the file name `CAM_TU_ASSEM_essentials`.

As a workaround:

1. Note the last part of the file name to identify the associated part file.
   For this example, the name of the associated part file is `essentials`.
2. Click Cancel to close the Save As dialog box.
3. Move the browser window that opens, so that it does not cover your NX session.
4. In the `MACH	utorials\parts` folder, open the `essentials.prt` file.

<table>
<thead>
<tr>
<th>Application</th>
<th>Manufacturing</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ribbon bar</td>
<td>Tutorials</td>
</tr>
</tbody>
</table>

### Fixture Planner

#### Product Notes

#### Template files

The Open dialog box displays only installed templates. You must import the standard template part files delivered with Fixture Planner into the Teamcenter database, so you can access these files in the Open dialog box. Other templates are not configured to work with Fixture Planner.

A setup script for installing Fixture Planner templates in Teamcenter is included with NX: 

```
%UGII_BASE_DIR%\MANUFACTURING_PLANNING\templates\tcin_fixtureplanner_template_setup.bat
```

For information about how to use the script, see Installing File New templates in the NX help.

#### Platform support

Fixture Planner is currently supported only on the Windows platform.
Manufacturing Additions installation

Using Fixture Planner with Teamcenter also requires you to install the Manufacturing Additions package to the Teamcenter server installation (For example, ManufacturingAdditions 2.9). Find the ManufacturingAdditions package in the Download or Upload Files section of the Global Technical Access Center (GTAC).

From the left side list of the product categories, choose Teamcenter and Teamcenter Rapid Start.

ManufacturingAdditions 2.5 and later supports the Fixture Planner in NX 1899.

Note:
To proceed with downloads from GTAC, you must use your webkey credentials. Alternatively, you can also search for the package in the search window. For example, search for “TC11.x_ManufacturingAdditions_2.9_wntx64.zip”.

Find instructions for applying the Manufacturing Plant extensions in the package .zip file (Plant Extensions - Deployment Guide.pdf).

Data requirements for Export

When you export the study, it should have the data with or without NX part files. You should save the study in the Fixture Planner before the export.

Note:
You should perform Save All for the study in NX, so you can see all the required part files in the study.

Importing Fixture Data

You can make changes in the fixture assembly data in native NX and then import only the fixture assembly in managed NX. This import allows the exchange of the relevant changes within the fixture assembly, and lets you update the planning scope of Fixture Planner.

Data requirements for Import

After you make changes in the fixture assembly in native NX, when you import back the changes of the fixture assembly to managed NX, the scope of the import should be the Fixture Assembly only, and not the study.

Documentation Notes

Note the following about the Fixture Planner documentation:
• Fixture Planner works with BVR data structures, and the documentation describes BVR procedures wherever required.
   In the release notes, you can find Fixture Planner in the CAM section.

Caveats

Loading the study with assembly load options

In Fixture Planner, while loading a study using assembly load options, you may observe the following behavior.

Minimally Load

NX currently supports the partially load and the fully load options, and does not support the minimal loading of the study and its components in a Minimally Load - Lightweight display option.

Line Designer

Product Notes

Template files

You must import the standard part files delivered with Line Designer into the Teamcenter database, so you can access these files in the New Item dialog box. If you do not perform this step, the New Item dialog box displays only blank templates.

A setup script for installing Line Designer templates in Teamcenter is included with NX:
%UGII_BASE_DIR%\MANUFACTURING_PLANNING\templates\tcin_linedesigner_template_setup.bat

For information about how to use the script, see Installing File New templates in the NX help at the following location:

Home→
Teamcenter Integration for NX→
System Setup/Administration→
Server Setup/Administration→
Installing/creating/modifying templates→
Installing File New templates

Platform support

Line Designer is currently supported only on the Windows platform.
Data Upgrade

Due to changes in the connector design in NX 11 and NX 12, equipment that uses connectors created in the previous versions should be upgraded to NX 12.0.2 MP5 or later format.

For more information, see *Using library components with connectors from NX 12.0.2 MP5 or earlier* in the Line Designer caveats.

Manufacturing Additions

Manufacturing Additions includes Teamcenter extensions to support the following:

**4GD Support**  
Use of Line Designer with 4GD capabilities requires a Teamcenter extension called 4GD Plant Design.

**FactoryCAD Library Migration**  
Migrating libraries from FactoryCAD to Line Designer also requires a Teamcenter extension to support new required dataset types. This extension is included in the Manufacturing Additions package to Teamcenter installation (ManufacturingAdditions 2.9).

You can get the Manufacturing Additions package to support 4GD and FactoryCAD Library Migration from the Download or Upload Files section of the Global Technical Access Center (GTAC).

You can find the Manufacturing Additions Windows and Linux packages from the EasyPlan And MfgAdditions section.

Note:
To proceed with downloads from GTAC, you must use your webkey credentials.

Find the instructions for applying the Manufacturing Plant extensions in the package zip file (*Plant Extensions - Deployment Guide.pdf*).

Factory resource samples

Installation of the sample factory resources, conveyors, and robots from the manufacturing resource sample library to Teamcenter is highly recommended.

- Factory Resources
- Factory Conveyors
- Factory Robots
- Factory Weld Guns
Instructions for installing the samples are located in the following section of the Teamcenter HTML documentation:

Home → Installing → Installation on Windows Servers Guide → Adding Features → Manufacturing → Installing and configuring the Manufacturing Resource Library

**Manufacturing Resource Library version compatibility**

Line Designer supports the use of factory resources with compatible versions of Teamcenter and Manufacturing Resource Library (MRL). You should find the latest version of MRL in the latest Teamcenter release.

**Note:**
You should always upgrade the Manufacturing Resource Library components from the previous release to the new release.

**Upgrading smart objects to the current NX version**

NX will automatically upgrade the older version of smart objects from previous NX releases to the new version when they are opened and saved in the new version of NX.

**Documentation Notes**

Note the following about the Line Designer documentation:

- Line Designer can work with either BVR or 4GD data structures, and the documentation describes BVR and 4GD procedures separately wherever required.
  In the release notes, you can find Line Designer in the CAM section.

**Caveats**

**Configured components in the Plant Navigator**

Configured out components from the plant structure appear as loaded components with no graphics in the Plant Navigator.

**Using library components with connectors from NX 12.0.2 MP5 or earlier**

While placing or disconnecting components in a layout, or while dragging components to another layout, you may experience incorrect behavior if those components have connectors created in NX 11 or earlier.
Recommendation

Before using the library objects in NX 12.0.2 MP5 or later Line Designer layouts, you should upgrade any part files of the library objects that include connectors created before NX 12.0.2 MP5. To do this,

- Open the library objects in NX.
- Open the Edit Connector dialog box.
- Click OK.
- Save the library objects in the later version.

Editing smart components in a layout

In a layout, when you edit a floor component or a platform component from the Reuse Library, the geometry of that component disappears.

Workaround    Change the reference set of that component, from Model to Entire Part.

Dragging in the Plant Navigator

In a layout, when you drag any component from the Reuse Library to a large assembly (approximately 5,000 components) in the Plant Navigator, you may observe a performance issue when you refresh the layout in NX, as the layout takes more time to load.

Note: Drag performance from the Reuse Library is better when you zoom in the specific area of a plant, where you want to add the dragged component.

Editing component attributes in the Plant Navigator

When you load the plant layout with the Minimal Load option, you may observe that the component attributes and properties are not editable in the attribute column, in the Plant Navigator.

Loading the plant layout with connected components

While loading the plant layout with connected components, you may observe the components as disconnected in the Plant navigator. The remedy to this issue is to restart the NX session, and again load the same plant layout.

Loading the shared study

In Line Designer, when you load a shared study using assembly load option, Minimally Load - Lightweight Display, position of the components may not appear correctly.
For more information on minimal loading, refer Minimal loading tips.

Creating occurrence poses

When you create occurrence poses for the components, NX shows no modifications for the parent component in the tree structure, in the Plant Navigator. Also, if the state of the component for which you create occurrence poses is Released, you may observe an issue that you can still create and save the occurrence pose.

Disconnecting components in a plant layout

In Line Designer, if you load a plant layout in NX using the assembly load option Minimally Load - Lightweight Display, the Disconnect Components command do not disconnects the connectors of the components.

Workaround  Load the plant layout data using the assembly load option, Partially Load.

Jogging the robot and the tool in a plant layout

In Line Designer, in a plant layout, when you connect a robot to a rail, mount the tool on the robot and use the Joint Jog command for rail, the robot and the tool do not move with the rail.

Also when you use Joint Jog command for the robot, the mounted tool do not move with the robot.

Disconnecting components in a plant layout

In Line Designer, when you load a plant layout data in NX and perform the Paste Duplicate on root components, NX does not display the duplicate component structure in the Plant Navigator.

Workaround  Reopen the plant layout data in NX.

Deleting the connected components in a layout

When you work in NX integrated with Teamcenter, load a plant layout, and you delete any component that is connected to another component, NX deletes all the connections in the layout.

This issue is fixed in Teamcenter 11.6.0.10, Teamcenter 12.2.0.5, and Teamcenter 12.3.
Additive Manufacturing

Product Notes

Feature toggle for new grouping feature

A new grouping feature is now available for early validation. This feature allows users to group parts in the build tray, and also to add and nest NX assemblies in the build tray.

Access to the new grouping feature is controlled by the Grouping parts in the build tray feature toggle (File→Utilities→Feature Toggles).

New version of Build Processor Interface

You must install the updated Build Processor Interface (BPI) Beta 4.0.27.0 version when you upgrade to NX 1899. This installs the latest updated 3.0.00032 version of the Build Processor System.

You will get this message until you install the (BPI) Beta 4.0.27.0 version: Incorrect version of the Materialise Build Processor Interface.

Before you install the BPI 4.0 version stop any Build Processor Manager process that may be running, uninstall the old BPI version, and then install (BPI) Beta 4.0.27.0 from this location:
%UGII_CAM_BASE_DIR%\mach\auxiliary\mfgam\BuildProcessorInterface.exe

Note:
You may need to resolve printers in the Build Processor Manager application, after you upgrade.

Automatic Nesting license change

From this release onward, you now require separate licenses for 2D and 3D nesting in NX Additive Manufacturing.

Templates

If you created your own template files in an earlier version of NX, you must do this before you upgrade to NX 1899: copy the template files from the templates folder (%UGII_CAM_BASE_DIR%\mach\templates) to a separate location to prevent the installation from overriding your defined templates.

After the upgrade installation is done, copy your template files to the %UGII_CAM_BASE_DIR%\mach\templates location.
Help enhancement: First Help

Now when you press F1 for help, you see initial help topics for select commands in the NX embedded browser. The web browser is available from the Resource bar, and you can double-click its tab to undock it.

With First Help, you can:

- Learn more effectively from visual content and videos.
• See examples that will help you get started with new or unfamiliar commands, and decide which command to use.

• Link from the navigation bar to additional help topics.

• Click the feedback button and let us know what you think.

In this release, First Help is added for the **Automatic Nesting** command.

**Caveats**

**User-defined supports**

When you move a part that has user-defined supports, the part is moved, but the user-defined supports do not move unless your user-defined supports reference part geometry (for example, edges or faces of the part model).

**Heat Sink support attribute**

The **Heat Sink** attribute is currently not visible for gusset support structures.

**Documentation Notes**

**Hands-on learning aids in the online help**

The online help now includes a limited number of hands-on procedures with part files to download, which let you work through detailed instructions on your own. These hands-on procedures are a good learning tool to try out new functionality and complex workflows. The procedure topics are titled **Hands-on: <Procedure name>**.

**Additive Manufacturing Process Simulation**

**Caveats**

• The software does not yet support automatically generating compensated/deformed geometry from computed deformations, for models created with convergent geometry.

• The application will run on a localized version of NX, but the deformation results (in case of solver slicing) must be selected manually, except for the English, German or French versions.
CMM Inspection Programming

CMM Inspection - New Features

Circular Arc Transition Moves

NX 1899

When programming inspection paths for round parts, you can specify the Transition Motion as Circular. This will produce transition moves between inspection points that follow the curvature of the part.

Curve Scanning Improvements

NX 12.0.2 MP12, NX 1899

A curve that is defined in NX using multiple segments can now be inspected as a continuous scan with control over the scan speed and point density for each individual segment. In the Curve Scan sub-operation dialog box, a list of control points is presented. The list is pre-populated with control points at the beginning and end of each curve segment. You can edit scan speed and point density at each control point.
These settings are implemented in the DMIS 3.0, DMIS 5.2, and MODUS (Equator) postprocessors using DMIS statements in the following format:

\[
\begin{align*}
P(\text{CURVE SCAN}_1) &= \text{PATH/CURVE}, <\text{point data for curve}_1> \\
P(\text{CURVE SCAN}_2) &= \text{PATH/CURVE}, <\text{point data for curve}_2> \\
P(\text{CURVE SCAN}_3) &= \text{PATH/CURVE}, <\text{point data for curve}_3> \\
P(\text{AMEAS/DISTANCE}, <\text{dist}_1>, \text{SCNVEL}, <\text{speed}_1>, P(\text{CURVE SCAN}_1), $ \\
& \text{DISTANCE}, <\text{dist}_2>, \text{SCNVEL}, <\text{speed}_2>, P(\text{CURVE SCAN}_2), $ \\
& \text{DISTANCE}, <\text{dist}_3>, \text{SCNVEL}, <\text{speed}_3>, P(\text{CURVE SCAN}_3) \\
\end{align*}
\]

Other postprocessors do not currently support these settings.

**Data Elimination and Data Filtering**

NX 12.0.2 MP10, NX 1880, NX 1899

*Data elimination* means the removal of measured data points, sometimes called *outliers*, that are outside a range of standard deviations from the mean deviation. *Data filtering* means a high pass, low pass, or band pass filter is applied to the measured data in order to isolate form deviation from surface texture. You can enable these and set the parameters using new groups in the feature dialog boxes and the method dialog box.
<table>
<thead>
<tr>
<th>Example</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1.png" alt="Image" /></td>
<td>Data elimination and filtering are turned off.</td>
</tr>
<tr>
<td><img src="image2.png" alt="Image" /></td>
<td>Data elimination based on a standard deviation multiple.</td>
</tr>
<tr>
<td><img src="image3.png" alt="Image" /></td>
<td>Low pass data filter</td>
</tr>
<tr>
<td><img src="image4.png" alt="Image" /></td>
<td>High pass data filter</td>
</tr>
</tbody>
</table>

These settings are supported by the DMIS 5.2 postprocessor using a statement in the following format:

```
GEOALG/CIRCLE,LSTSQR,STDDEV_LIMIT,2.,FILTER,CIRCULAR,HIGH,15.,GAUSS
```

Other postprocessors do not currently support these settings.

**Head Touch on Outer Circles and Cylinders**

NX 12.0.2 MP10, NX 1880, NX 1899

Simulation of inspection paths using the PH20 in Head Touch mode has been improved for the following feature types:

- CIRCLE/OUTER
- CYLNDR/OUTER
- GCURVE on the surface of a CYLNDR/OUTER
Verify Program

NX 12.0.2 MP10, NX 1880, NX 1899

You can now verify inspection programs before sending them to the shop floor for execution. Many common errors are detected and reported in the NX information window.

- Feature not measured or constructed
- Datum not defined before a tolerance that references it
- Size tolerance missing when using MMC or LMC modifiers

Arc Scan using Rotary Table

NX 12.0.2 MP8, NX 1880, NX 1899

You can now perform arc scans by bringing the probe into contact with the part, then rotating the part with the rotary table while holding the probe at a stationary XYZ. You can specify this on the Scan Arc dialog box using the new Rotary Table choice for Scan Mode.

This is supported by the DMIS 5.2 postprocessor using a statement in the following format:

```
PAMEAS/P(CIRCLE1_PATH_Scan_Arc),ROTARY,RT(ROTARY1)
```

Other postprocessors do not currently support this statement type.

Support for Valisys programs

NX 12.0.2 MP8, NX 1880, NX 1899

Inspection programs written using Valisys (eM-ProbeCAD) may now be imported into NX CMM with good success. Fewer than 10% of operations will need to be edited by hand. Support for the following statement types was added in NX 12.0.2 MP8:

- DATSET statement
- MACRO and CALL statements
- CONST/POINT,…,BF
- Convert 3 character datum letters VP1,VS1,VT1 to valid datum letters
- Option to ignore BND1,BND2,BND3,BND4,F(VBND and BOUND/
- Option to ignore Comments
• OUTPUT that isn’t a T() or F() format
• Valisys GEOALG formats
• GSURF/GCURVE Features
• Width Tolerance
• OUTPUT/R()
• TEXT/OPER
• ROTAB/
• SAVE/FA

**Link PMI Processing of Ordinate Dimensions**

**NX 12.0.2 MP5, NX 1880, NX 1899**

When processing ordinate dimensions, the Link PMI function now inserts operations into the CMM program to establish a Part Coordinate System (PCS) at the origin of the ordinate dimension. If several ordinate dimensions are based on the same origin, they will share the same PCS. The PCS column in the Operation Navigator will show the PCS assigned to the CORTOL tolerance.

**Link PMI Processing of Hole Callouts**

**NX 12.0.2 MP5, NX 1880, NX 1899**

The Link PMI function now links PMI Hole Callouts into the appropriate set of CMM Inspection operations. The following hole types are supported:

• Cylindrical Through Hole
• Threaded Hole
• Counterbored Hole
• Countersunk Hole
• Blind hole (non through hole)
• Tapered Hole

Inspection features, tolerances, and paths are created to measure the following characteristics:
• Cylinder Diameter
• Counterbore Diameter
• Countersink Angle
• Counterbore Depth (using plane features)
• Countersink Depth (using constructed circle)
• Hole Depth (using point features)
• Tapered Hole Cone Angle

Note:
Hole depth is measured using point features in order to minimize inspection time.

Path Programming using Rotary Table

NX 12.0.2 MP5, NX 1880, NX 1899

When programming a part involving a rotary table, the inspection part and rotary table will be displayed in the rotated position when you view and edit inspection paths.

CMM release notes

PAX file change

The .pax files are now located in the UGII_BASE_DIR\cmm_inspection\templates folder.

VALISYS critical maintenance and retirement notice

The VALISYS application is unsupported as of July 21, 2016. Use the NX CMM Inspection Programming application instead of VALISYS Programming and use CMM Inspection Execution instead of NX-Inspect.

Linking to PMI information

All geometry referenced by PMI must be in the current reference set, and if it is not, then NX:

• Issues warning messages in the information window.
• May still create features, but will not create paths because there is no access to the feature geometry.
Caveats

Renaming or deleting the SENSORS group

In the Inspection Navigator, do not delete or rename the SENSORS group as this may cause machine simulations within the Inspection Path dialog box to fail.

Machine simulation

When you create an inspection path or simulate a program, you may see the following INI Programs message:

In order to handle INI files in the Program Manager, define the channels in the Machine Tool Builder.

You can ignore this message for NX CMM Inspection applications. It has no effect on the machine simulation.

Knowledge Fusion and DesignLogic functions

Product Notes

Impact of angle base units on custom Knowledge Fusion and DesignLogic functions:

Customers who use NX interactively should see no impact from this change. Customers automating NX programmatically should read this section carefully.

The internal base units for angles are now radians instead of degrees. Internally, calculations involving angles will be converted to radians while the calculation is performed. This change enables certain new calculations involving angular units. This affects not just the angle measurements but every measurement that includes angular dimensions as shown in the following table.

<table>
<thead>
<tr>
<th>Measure</th>
<th>Base units before radian-based</th>
<th>Base units in radian-based</th>
</tr>
</thead>
<tbody>
<tr>
<td>Angle</td>
<td>degrees</td>
<td>radians</td>
</tr>
<tr>
<td>Angular Velocity</td>
<td>degrees/sec</td>
<td>radians/sec</td>
</tr>
<tr>
<td>Angular Acceleration</td>
<td>degrees/sec^2</td>
<td>radians/sec^2</td>
</tr>
<tr>
<td>Angular Jerk</td>
<td>degrees/sec^3</td>
<td>radians/sec^3</td>
</tr>
<tr>
<td>Per Angle</td>
<td>1/degree</td>
<td>1/rad</td>
</tr>
<tr>
<td>Angular Momentum per Angle</td>
<td>mN-mm-sec/degree</td>
<td>mN-mm-sec/rad</td>
</tr>
<tr>
<td>Moment per Angle</td>
<td>mN-mm/degree</td>
<td>mN-mm/rad</td>
</tr>
<tr>
<td>Voltage per Angular Velocity</td>
<td>microV-sec/degrees</td>
<td>microV-sec/radians</td>
</tr>
<tr>
<td>Length per Angle</td>
<td>mm/deg</td>
<td>mm/rad</td>
</tr>
<tr>
<td>Measure</td>
<td>Base units before radian-based</td>
<td>Base units in radian-based</td>
</tr>
<tr>
<td>---------------------------------------------</td>
<td>-------------------------------</td>
<td>---------------------------</td>
</tr>
<tr>
<td>Per Angle Squared</td>
<td>1/degree^2</td>
<td>1/rad^2</td>
</tr>
<tr>
<td>Mass Moment of Inertia Per Angle</td>
<td>kg-mm^2/deg</td>
<td>kg-mm^2/rad</td>
</tr>
</tbody>
</table>

Custom DesignLogic and Knowledge Fusion functions with parameters involving angular dimensionalities may need to be scrutinized for accuracy.

- Functions that have been authored using pure KF language may not be impacted. Any special coding done by you to handle units/unit conversions in your functions should work the same as they did in NX 1872.

- Functions that make calls to UG Open/Ufunc accepting and returning dimensionalities with angles may be impacted. Even those that don’t may be impacted.

For example, the functions floor() and ceiling() had to be changed because they sometimes may receive a value that has an angle dimension, in which case UF_KF_ask_number() would return a radian value.

You might have special custom coding to apply unit conversion from degrees to radians in such cases which may no longer be necessary. We also recommend looking into the APIs UF_KF_ask_number_with_measure & UF_KF_make_number_with_measure that provide numbers in degrees while preserving the dimensionality. Using these APIs instead of UF_KF_ask_number & UF_KF_make_number may help achieving the original intent of the KF/DL functions. For example:

```c
//========================================
DllExport extern void supplementary_Angle(UF_KF_value_p_t *data, int num, UF_KF_value_p_t *rv)
{
    //Initialize UF session
    UF_initialize();
    double angle=0;
    char *dim = "";

    // Extract a degree-based value and its dimensionality from an input argument
    UF_KF_ask_number_with_measure(data[0], &angle, &dim);
```
Calculate supplementary

double comp = 180 - angle;

// Prepare a return value with a given dimensionality.
UF_KF_make_number_with_measure(comp, dim, rv);

UF_terminate();
}

Validation

Check-Mate and Requirements Validation

Caveats

Validation rules

Validation rules do not recognize unset part attributes.

Using NX Issue Management

To use NX Issue Management, Teamcenter Issue Manager must be deployed from the server by the Teamcenter Environment Manager. If NX cannot connect to Teamcenter Issue Manager, you will see a message. For more information, see the Teamcenter Environment Manager help.

Using Teamcenter for NX Issue Management

When you use NX Issue Management, you can specify Teamcenter as the issue site only when Teamcenter Issue Manager is deployed by Teamcenter Environment Manager on the server side.
Tooling Design

Tooling Design documentation notes

Hands-on learning aids in the online help

The online help now includes a limited number of hands-on procedures with part files to download, which let you work through detailed instructions on your own. These hands-on procedures are a good learning tool to try out new functionality and complex workflows. The procedure topics are titled Hands-on: <Procedure name>.

Press Die Checker

Product Notes

Platform support

Press Die Checker is currently supported only on the Windows platform.

OmniCAD

Product Notes

OmniCAD

Starting with NX12.0.1, you are no longer required to run the InstallSentinel.bat file to run commands in the OmniCAD for NX application.

Mold Wizard

Optimized settings for MW Part Family Library

There are several recommended settings to improve the performance of your session of Mold Wizard. These settings are located within the Customer Defaults, Visualization Preferences, and Selection Preferences dialog boxes. You can double-click MW_Setting.vb located in the MW Part Family Library to automatically set the following:

Customer Defaults

• Disable missing interpart warnings.
• Disable material to avoid material part attribute conflicts.
• Set the pocket color to match the tool body color when you create new geometry.
• Disable creating part and model view preview images at any time during the design.
• Disable Update Reading Direction after View Rotate for PMI.
• Enable double-clicking a feature to edit its parameters.
• Enable **Apply Changes to Owning Part** when editing an object's display parameters.
• Treat a **Degree 1** spline as a polyline.

**Visualization Preferences**

• Enable session translucency.
• Disable emphasis precedence for the work part.

**Selection Preferences**

• Disable **Highlight Selection on Rollover**.

**Progressive Die Wizard**

**Optimized settings for PDW Part Family Library**

There are several recommended settings to improve the performance of your session of Progressive Die Wizard. These settings are located within the **Customer Defaults**, **Visualization Preferences**, and **Selection Preferences** dialog boxes. You can double-click **PDW_Setting.vb** located in the **PDW Part Family Library** to automatically set the following:

**Customer Defaults**

• Disable missing interpart warnings.
• Disable material to avoid material part attribute conflicts.
• Set the pocket color to match the tool body color when you create new geometry.
• Disable creating part and model view preview images at any time during the design.
• Disable **Update Reading Direction after View Rotate** for PMI.
• Enable double-clicking a feature to edit its parameters.
• Enable **Apply Changes to Owning Part** when editing an object's display parameters.
• Treat a **Degree 1** spline as a polyline.

**Visualization Preferences**

• Enable session translucency.
• Disable emphasis precedence for the work part.

**Selection Preferences**

• Disable **Highlight Selection on Rollover**.
Data translation

Product Notes

Updates for the default tessUG.config JT configuration file

• To ensure that you are using an up-to-date configuration file, we highly recommend using the tessUG.config configuration file included with NX and customizing it per your current settings.

• Make sure you delete all the references to the activateCsysPMI option in the JT configuration file. If activateCsysPMI = true is set anywhere in the configuration file, the translator stops the translation process.

• The doSectionViews configuration option which is used to process non-lightweight PMI section views (also known as heavyweight section views) is removed from the default tessUG.config file shipped with NX11. This option is now renamed as LegacyHeavyweightSectionViews. If your existing NX part or assembly contains section views created using PMI tab→Section View command in Pre-NX11 versions and you want to translate these section views to a JT file, you need to add LegacyHeavyweightSectionViews option in your tessUG.config configuration file and set it to true.

CATIA V5 translator product notes

You can now import the following type of files to NX:

• CATIA V5-6R2018 SP3 files
• CATShape files
• CGR files

You can now set Include Reference Geometry as a translator option.

ACIS translator product notes

You can now read and write ACIS version up to R28.

DXF/DWG translator product notes

You can now read and write AutoCAD DXF/DWG version up to 2019.

NX to JT translator product notes

NX to JT translator now supports the IRAY texture material translation to the JT file.
NX ProE translator product notes

You can now import Creo5.0 files to NX.
Caveats

Limited support for new line styles

The following NX translators do not support the new OOTB and shipbuilding line styles, and write them as Solid line style:

- CATIA V5
- IGES
- NX to JT
- STEP 203, 214, and 242

Internationalization caveat

File import or export by the following translators may not work if you set the NX temporary directory UGII_TMP_DIR to a folder containing non-locale characters.

- DXF/DWG
- IGES
- STEP
- 2D Exchange (export only)

NX to JT translator caveats

NX to JT translator caveat for the Windows operating system

If you are translating pre-NX11 parts with material, texture, and light applied on it and you want to get the texture or light information into the JT file, We recommend you to invoke NX in Author2 (non-IRAY+) rendering mode and then translate the parts to a JT file. This recommendation is applicable for JT creation from interactive NX session as well as command line application ugtopv. Contact GTAC to get more information on how to invoke NX in Author2 (non-IRAY+) rendering mode.

Note:

If you invoke NX in Author2 (non-IRAY+) rendering mode then these options will be available in the JT Configuration and the Export JT dialog boxes.

NX to JT - IRAY texture and material caveats
In some situations, you may find differences between the quality of the texture displayed in NX and that displayed in JT, when you view it in the Teamcenter Visualization.

**DXF/DWG translator caveats**

File→Export→DXF/DWG does not work in NX manager.

**DXF/DWG — Dimension export caveats**

These caveats are applicable when you export a file using the 3D option in the AutoCAD DXF/DWG Export Wizard dialog box.

- Dimensions associated with external references are exported as non-associative dimensions to the DXF/DWG file.
- NX Radius dimensions associated with ellipse or spline object are translated as AutoCAD block reference.
- The dimension associated between NX sheet object and View port object may be translated as overridden text of AutoCAD dimension.
- Narrow dimensions are exported as non-associative dimensions to the DXF/DWG file.
- Chamfer and Thickness dimensions are exported as block reference to the DXF/DWG file.
- Angular dimensions created with vector option are exported as block reference to the DXF/DWG file.
- Dimension with fits tolerance having fit tolerance style other than Fit Symbol is exported as block reference in AutoCAD.
- Dimension text location may not match with NX for the dimensions created with oriented text.
- Dimension line breaks and foreshortening symbols are not supported when dimension is exported as group or block.
- If a dimension text is on the extended dimension line, the exported dimension has to be updated to view any foreshortening symbols on it.

**DXF/DWG — MText import caveats**

You cannot import:

- MText paragraph tabs to NX.
- Euro symbol (created using %%128 in MText) to NX.

**DXF/DWG — Architecture data import caveats**
• You can not import:

  • View dependent data
  • Texture data
  • Corner windows
  • Wall cleanups
  • Body modifiers on staircase

  • Associativity defined between the architecture objects is not maintained in NX. For example, door on wall will not move along if wall is moved.

**DXF/DWG — Solids import caveats**

You cannot import:

  • Material, color, and transparency applied on solids in the DXF/DWG file.

  • Solids data at location outside the NX supported bounding box.

**DXF/DWG translator- Image translation Caveats**

  • When you import DXF/DWG model data to NX drawing view, the translator does not support image translation.

  • When you import DXF/DWG file that contains image rotated by angle which is not in a multiple of 90, the image is imported with zero degree rotation.

```plaintext
Note:
In NX, the images are rotated in steps of 90 degrees only.
```

  • When you import DXF/DWG file with images having other than .jpeg, .tiff, and .png formats to NX, the translator does not support importing of such images.

  • Images are not imported if exported as CGM.

  • Image translation is not supported if the DXF/DWG file is imported to workpart.

**DXF/DWG translator- 3D Workflow caveats**

When you export View Breaks using 3D workflow, the translator does not support an export of the following:

  • NX Object clipping and view break symbols.
• Geometry clipped inside a view boundary.

• A section line arrow in Break view.

Dimension export using 3D workflow

• When a dimension is exported as a block reference, the foreshortening symbol is not supported.

• 3D workflow does not support the inclusion of before/after appended text in the export of the inspection dimension. It always includes all the appended text in the frame.

• The translator does not support a tolerance separator in the output DXF/DWG file.

Text export using 3D workflow

• When you export text as lines using 3D workflow, the translator ignores the text symbol aspect ratio.

**DXF/DWG translator- Associative dims to polyline and block caveats**

You cannot import dimension as real associative in following scenarios:

• Blocks are imported as custom symbols or as a part and if dimensions are associated with block reference in the DXF/DWG file.

• Dimensions are associated to 2D and 3D polyline.

• Dimensions that have following Object snap points:
  
  • Tangent
  
  • Perpendicular
  
  • Nearest
  
  • Apparent Intersection
  
  • Parallel
  
  • Intersection

• Dimensions are associated to arc segment of the polyline.

**DXF/DWG translator- Support for drafting objects caveats**

You can not export:

• Drawings created in the **Layout** application using the **2D** option.
• Custom symbols used in a PMI table.

• Section views.

DXF/DWG Support for Hole table

If the multiple sections of the hole table are created on different drawing sheets, the continuation text will be lost.

2D Exchange caveats

• File → Export → 2D Exchange does not work in NX manager.

• Object attributes with title longer than 50 characters or string value longer than 132 characters are not exported to 2D parts.

2D Exchange – Dimension export caveats

These caveats are applicable for both, when you export a file using the NX Part file option in the 2D Exchange Options dialog box or when you export a file using the 2D option in the AutoCAD DXF/DWG Export Wizard dialog box.

Following dimensions are exported with the Override Dimension Text:

• Feature Parameter Dimensions

• True Length Dimensions

• Dimensions in scaled view and output set to Modeling (applies only when you export a file using the NX Part file option in the 2D Exchange Options dialog box)

• Dimensions associated to:
  • Drafting Intersection point
  • Offset center point
  • Section line (in scaled view)

• The dimensions where associated object type changes in the flattened part. For example, circle projected as line.

Following Data will be exported as grouped geometry in the 2D part file and as a block in the DXF or DWG file.

• Linear and Radial callouts

• Retained dimensions
• Component level dimensions and PMI dimensions

• Inherited ordinate PMI dimensions

• Dual dimension in scaled views and output set to Modeling.

• Dimension with hole and shaft tolerance in scaled views and output set to Modeling.

• Dimensions associated with:
  • Blanked objects
  • 3D and Symmetric centerlines
  • Faces
  • Two object intersection (applies to ordinate dimension only)
  • Target Points

• Dimension created in plane other than view plane.

• PMI Partial Bolt Circle centerline.

2D Exchange translator- Image translation caveats
• 2D Exchange Translator does not translate image, if image is not projected on 2D. This happens when image is in XY plane and trimetric view is exported.

• 2D Exchange Translator supports translation of images only if input is being exported to Part File and not to IGES).

2D Exchange translator- Dimension export caveats
• When Dimension and a Leader are associated with the symmetrical centerline, the translator exports them as a grouped geometry.

• When a radial dimension is associated with a break view geometry, the translator exports it as a group geometry.

• When a perpendicular and angular dimension is associated with a break view section line, translator exports them as a group geometry.

2D Exchange translator - Foreshortening Symbol export caveats
A translator does not support export of foreshortening symbol when dimension is exported as a group in a 2D part.

2D Exchange translator – Leader caveats
A leader with an extension line is converted as a grouped geometry when it is associated with a spline in a 2D part.

2D Exchange translator – Weld symbol caveats
When you export a weld symbol containing arcs, the translator exports it as a grouped geometry.

2D Exchange translator – Support for drafting objects caveats
You can not export:

• Drawings created in the Layout application

• Custom symbols used in a PMI table.

• Section view while exporting Model views.

2D Exchange Support for Hole table
If the multiple sections of the hole table are created on different drawing sheets, the continuation text will be lost.

DXF/DWG and 2D Exchange - PSM body support project caveats

• If you export convergent bodies as polyline mesh, it exports only edges.

• Colors are not honored when you import 3D faces as convergent bodies or JT facets.

• Colors applied to face of convergent body is not honored on export.

• You cannot export model views with convergent bodies with 2D Exchange (or using 2D option on DXF/DWG export dialog box).

STEP translator caveats

• When you export or save NX data to a .stpx file, STEP translator does not export nested external references.

• When you export NX data containing PMI lightweight section views to STEP242:
  
  • Selective object sectioning is not supported.

  • Section plane display properties are not supported.

  • Section view cross-hatch is not supported.

• When you export NX data to STEP AP242, the translator does not support layer mapping and does not support layer mask.
• When you export NX data to STEP AP203, AP214, or AP242, the translator does not support NX layer categories.

**CATIA V5 translator caveats**

• The translator exports NX files to CATIAV5 R14 files.

• You cannot import CATIA V5 R7 and earlier version of files.

• You cannot translate standard and user defined attributes.

• Color is supported on a per face basis.

• You can only import CATIA V5 “Lines and Curves” into NX using default “Linetype” and “Thickness” values.

• You cannot export NX parts with file name containing international characters.

• The CATIAV5 translator does not keep a log of failed export of password protected data during translation.

• When you import a CATIAV5 file in NX using **File→Open** method, NX does not automatically save the output file on the disk. You can decide whether to save it or not.

• Before re-importing a CATProduct with different content (potentially due to option choices), it is best to manually delete previous output files in case the IDs in the node or component part filenames shift.

• During import, the translator will look for component files at and below any directories specified through Assembly Search Directories.

• The translator looks for the default settings file in the following sequence:

  1. Settings file specified using the d= option if you launch the translator from command line prompt.

  2. Settings file specified using the NX_CATIAV5_DEF environment variable.


  4. Searches for the settings file in the directory specified by the environment variable UGI_CATIAV5_DIR. If this is not defined on your system, you can set it to %UGII_BASE_DIR%\catiav5 on Windows or $UGII_BASE_DIR/catiav5 on Linux.
Caveat for all translators

The password protected parts or assembly components are not exported to other file formats.

System Administration

Updating the NX Installation

Product Notes

The Siemens NX Launcher that is installed in NX 1899 can automatically detect NX programs that are installed in NX 1872 and later.

When you upgrade Siemens NX Launcher in NX 1899, you can:

- Create environments for the latest versions of NX programs.
- Launch the latest versions of NX programs.

The Siemens NX Launcher that is installed in NX 1872 cannot automatically detect NX programs that are installed in NX 1899 or later.

If you continue using the older version of the Siemens NX Launcher, you can manually add paths of installation directories of all the latest versions of NX programs in the OEM_Environment_Def.xml file, which is available at C:\ProgramData\Siemens.

Mechatronics Concept Designer

Product Notes

PLCOpen XML export for STEP 7

Mechatronics Concept Designer can export the sequence of operation in the standardized XML format PLCOpen XML. PLCOpen XML can be imported into STEP 7 5.5 SP 2 Hotfix 4 and above. If you need to update your current STEP 7 installation you can find information about the latest service packs and hotfixes at the following:

English: https://support.industry.siemens.com/cs/products?dtp=Download&mfn=ps&pnid=14342&lc=en-WW

Signal exchange between Mechatronics Concept Designer and external system

Previously, when you exchanged signals between Mechatronics Concept Designer and an external system, the software automatically converted one of the numeric values so the units matched. Due to a design change in MCD, the signal exchange only considers the numeric value, regardless of the assigned units, so you need to manually verify the values.
Runtime Expression units

If you use a Runtime Expression formula without assigning a unit to the result and then you assign the result to a linear parameter, such as linear velocity, the unitless value uses the SI unit of the linear parameter. This is a PR and will be fixed in NX 1876.

Automation Designer

Requirements for running Automation Designer NX 1899

• Software platform
  • NX 1899
  • Teamcenter 11.6.0.4 or Teamcenter 12.1.0.5 and later or Teamcenter 12.2
    Automation Designer must be set up as a client/server application with a preconfigured Teamcenter installation
  • (Optional) Active Workspace 4.1 and higher

• TIA Portal
  A valid TIA Portal license
  • STEP7 Professional Combo V15, V15.1 or V16
  • STEP7 Safety Advanced Combo V15, V15.1 or V16
  • Drive Support: SINAMICS Startdrive V15, V15.1 or V16

  Note:
  Automation Designer can no longer exchange data with TIA Portal V14.SP1. But you can still export program blocks of TIA Portal V14.SP1 to a higher TIA Portal version.

• EPLAN
  A valid EPLAN runtime license and EPLAN runs on the same machine as Automation Designer.
  The standard EPLAN Electric P8 installation provides EPLAN project templates.
  Automation Designer supports only zw9 files.
  • EPLAN Electric P8® v2.7
  • EPLAN Electric P8® v2.8
  • EPLAN — EADN:Application 0193
• eCl@ss
  Using the eCl@ss standard requires a valid license. The Terms of Use for the eCl@ss standard states: "This content contains eCl@ss. The use of the eCl@ss standard requires a license. Please register and order in the DownloadPortal (www.ecl@ssdownload.com)."
  Automation Designer supports eCl@ss ADVANCED Version 8 and newer.

• Operating system requirements
  Automation Designer supports the versions of Windows as supported by NX.
Caveats

General

• If you update many objects, for example for generation or printing, and another user has checked out one of these objects, the operation may be stopped and rolled back. Assure that only one user has opened the project.

• When you copy and paste objects or you create templates from an existing project, the objects can be displayed in a different order. You may not notice this if automatic naming is applied.

• You cannot reference an attribute for a selection of multiple objects in bulk properties view. Only one of the selected objects references the attribute.

• When you enter data for an Automation Designer property and the number of digits or storage format does not correspond to the allowed values in Teamcenter, a "Too many digits" error occurs. This also happens while mapping to an external object. If you update an Engineering Object to another revision, this error is reported in HD3D. As a result, this property value is not saved in Teamcenter classification and it is not available in Teamcenter clients, in searches, or reports. Either extend the allowed number of digits or characters in Teamcenter, or reduce the length of the expected value by truncating or rounding in the calculation in Automation Designer.

• Automation Designer does not support upgrading Teamcenter to version 12.2.0.3 or later when Automation Designer NX 1899 operated before. It supports upgrading Teamcenter to version 12.2.0.3 or later when Automation Designer is upgraded from a previous version to NX 1899 afterwards. If you plan to upgrade both, Automation Designer and Teamcenter always upgrade Teamcenter before you upgrade Automation Designer.

Products

• If you change the structure of a product and use the Save as command, part corruption occurs. If you use a new product, use first the Save command before using the Save as command. If you use an existing product, use the Save as command before changing it and use then the Save command.

BOM

• A generated BOM report can show components of a product as children of the product in the structure of the BOM. If you do not want this, apply the closure rule BOMExpandSkipByADItemType. In Teamcenter Rich Client, select Tools → View/Set Closure Rule for Expansion.

Collaboration

• If multiple users create subsets for the same mechanical data in the same project, some mechanical data is greyed out in the Collaboration Navigator and invisible in the 3D model. To avoid this, assure
that only one user creates a subset and publishes the collaboration context. All other users use the **Load external objects** command.

- If multiple Automation Designer projects use the same mechanical design, you can only map one Engineering Object to the same mechanical component at a time. In other Automation Designer projects, the object mapping buttons are not available for the component. To map a mechanical component, this component must be unmapped in any other Automation Designer project, in which it was mapped before.

- Compound properties of customized business objects that are mapped to an Engineering Object do not have their properties shown as properties of the Engineering Object.

- After transferring library objects between Teamcenter sites or changing the naming rules of the site by editing the library object, might result in errors. Assure that the naming rules of the site include the IDs of the library objects.

- Avoid to create multiple subsets to the same Collaborative Design.

- Subset configuration does not support Teamcenter baselines of (mechanical) Collaborative Designs.

**Snapshot**

- Using the functionality to inspect a snapshot is limited and experimental. NX interrelated parts might resolve to a newer part than the one that is member of the snapshot. You must set the environment variable `AD_ENABLE_INSPECT_SNAPSHOT=1` to use the functionality. You can only inspect a snapshot if the same project is closed and no other snapshot inspection is currently running.

**Automation**

- If you connect motors to Sinamics S210 stations, the export to TIA Portal fails.

- The hardware version of the CPU is lost during data migration. During export the newest available firmware version is selected. This firmware version might not support the OPC settings of software blocks and results in an export failure. The same failure can be caused by incompatible software blocks from the library. Assure that the firmware version of the CPU supports the software blocks. Check the value of the firmware version after data upgrade. If the issue persists, the software block from the library is incompatible to the firmware version of the CPU.

**Software Generation**

- If you undo the deletion of a method in the software block view, it can cause a severe error.

- Upgrades of software blocks to a new revision is reset to the old revision by existing IDBs.
• Automation Designer does not support overlapping variables in FBs.

Navigations and Expressions

• If the symbolic name of a FB is dynamically calculated and the FB changes then, the system calculated property DB of of a DB fails to update, when the DB is moved in the navigator.

Electrical Design

• When you add a fragment in template usage to a page in template usage, and the template is broken after deleting the parent Engineering Object, Automation Designer results in an error and switches to NX Gateway.

• If you copy a page from an open project to another one, causes an error.

• You cannot place a fragment on a page through an expression.

Symbol editing

• If you combine custom symbols, you must apply the Smash command while creating or defining geometry for custom symbols. Otherwise the symbol graphic is not displayed if the symbol is placed on the page.

Reports

• You cannot use cable diagrams with user-defined sorting criteria.

Cabinet Design

• Concurrent collaboration of two users on the same cabinet is not supported.

• It is possible to select an inactive cabinet when you create a view of a cabinet. This results in an error in cabinet design. Select only active cabinets.

• Switching the active window while creating a view of a cabinet causes an error.

• PMI notes created for a cabinet design might not be visible on views created from the design.

• If you move components of an assembly that has multiple occurrences of the same part, causes an error. Apply Make Unique to these components in NX Assembly Navigator, before using it in cabinet design. You can switch from 3D product model environment to NX Modeling.

• You cannot use the Undo command after you deleted a view page in the Document Navigator.
**Documentation Notes**

**Update for the Configure the Reuse Library topic**

The description includes steps that are no longer necessary. You can skip step 3 and 4. System selects automatically Automation Designer.

**Programming Tools**

**Open C**

**New Open C routines**

The following routines are new for this release:

- UF_FACET_ask_errors_during_tessellation
- UF_FACET_ask_face_of_tessellation
- UF_FACET_ask_facet_data_of_tessellation
- UF_FACET_ask_num_facets_in_tessellation
- UF_FACET_delete_tessellation
- UF_FACET_tessellate_face
- UF_PART_translate_jt

**Obsoleted Open C routines**

The following routines are now obsolete and will be deleted in the next major release of NX:

- uc6001
- uc6025
- uc6031
- uf6009
- uf6010
- uf6032
- uf6035
- uf6036
- uf6044
- uf6046
- uf6048
- uf6071
- UF_MECH_create_gear_joint

**Deleted Open C routines**

The following routines are deleted for this release:
Functions:
UF_ROUTE_set_characteristics
UF_ROUTE_ask_characteristics
UF_ROUTE_delete_characteristics
UF_ROUTE_load_part_by_charx
UF_ROUTE_set_charx_env
UF_ROUTE_update_charx_env
UF_ROUTE_ask_charx_env
UF_ROUTE_match_charx_in_plib
UF_ROUTE_free_match_results
UF_ROUTE_free_charx_array
UF_ROUTE_find_title_in_charx
UF_ROUTE_find_terminal_charx
UF_SF_get_auto_element_size
UF_SF_ask_element_type_names

Structures:
UF_EPLIB_charx_s
UF_ROUTE_characteristic_match_plugin_s
UF_ROUTE_split_descriptors_plugin_s
UF_ROUTE_cb_fab_data_s

#Defines:
UF_ROUTE_CHARX_TYPE_UNKNOWN
UF_ROUTE_CHARX_TYPE_INT
UF_ROUTE_CHARX_TYPE_REAL
UF_ROUTE_CHARX_TYPE_STR
UF_ROUTE_CHARX_TYPE_ANY
UF_ROUTE_CHARX_TYPE_REF
UF_ROUTE_CHARX_TYPE_ANY_REF
UF_ROUTE_CHARX_TYPE_INT_EXPR
UF_ROUTE_CHARX_TYPE_REAL_EXPR
UF_ROUTE_CHARX_TYPE_STR_EXPR
UF_ROUTE_CHARX_EXPR_unknown
UF_ROUTE_CHARX_EXPR_err_num_eq_eq
UF_ROUTE_CHARX_EXPR_err_num_eq_rel
UF_ROUTE_CHARX_EXPR_err_num_eq_none
UF_ROUTE_CHARX_EXPR_err_num_eq_str
UF_ROUTE_CHARX_EXPR_err_num_num_eq
UF_ROUTE_CHARX_EXPR_err_num_num_rel
UF_ROUTE_CHARX_EXPR_err_num_num_num
UF_ROUTE_CHARX_EXPR_err_num_num_str
UF_ROUTE_CHARX_EXPR_err_num_range_eq
UF_ROUTE_CHARX_EXPR_err_num_range_rel
UF_ROUTE_CHARX_EXPR_err_num_range_range
UF_ROUTE_CHARX_EXPR_err_num_range_str
UF_ROUTE_CHARX_EXPR_err_num_rel_eq
UFROUTE_CHARX_EXPR_err_num_rel_rel
UF_ROUTE_CHARX_EXPR_err_num_rel_none
UF_ROUTE_CHARX_EXPR_err_num_rel_str
NX Open

NX Open differences between releases

The NX Open differences between releases and deprecated items replacements are now published in the Documentation Center.

In the Documentation Center, for your release, click What's Changed in NX Configuration and NX Open. From there, click NXOpen APIs to open the NXOpen APIs What's Changed Reports webpage.

You can select the Changes That May Require Code Changes tab to view the changes that have occurred for the release and any that might require changes to your existing code. The What's New tab provides new items for the release.

You can compare your release to another one to see the amount of change that has occurred between the two releases. In the Comparing NX <your release> and: listing, select the release you want for comparison, and click Compare. You can get comparisons for up to two years of releases.
Release upgrades

A primary goal of NX Open is to maintain your automation investments. This is done by adopting policies which minimize the amount of required code changes by you to migrate your applications to new releases of NX. The following contains a description of these policies and how they impact your ability to support the users of your applications, and the steps you should take to successfully move your application to new releases of NX.

NX Open API change policy

NX maintains the following three primary policies to protect your investments:

• **API stability**
  Stability ensures that the API that has been released will continue to work. This means that the API is still present in future releases and the behavior of the API doesn't change. API changes should be designed to minimize any changes to your source code. For example, if the capabilities of a method are expanded which requires new parameters, then NX may maintain and optionally deprecate the original method and add a new method that includes the new capabilities. By doing this, existing applications do not require code changes unless they want to take advantage of the new capabilities.

• **Binary compatibility**
  Compatibility means that applications that are built against a specified release continue to work with subsequent releases. This requires not only that API stability is maintained but also is binary compatible. For example, re-ordering the values of enum members so that API stability is maintained. In this case, the values have changed so existing automation programs will be using the wrong values. In other cases, deleting a method or modifying the inheritance hierarchy of a class will likely cause run-time errors for existing programs.
  The other aspect of binary compatibility is the compiler. When the compiler NX uses changes, this may break binary compatibility of automation programs. While some language bindings are more tolerant of being backwards compatible, such as Java, others are not as tolerant, such as C++.
  NX libraries will be forward compatible for all releases in a release family. If you compile and link your application with the libraries shipped with a functional release of NX, such as NX 1847, then your application should continue to run with all future monthly releases in that release family (NX 1847). This compatibility means you do not need to recompile, relink, and reship your applications to customers running various monthly releases of NX. Note that NX is not backwards compatible, which means you can’t compile and link an application in NX 1847 and expect it to work in NX 12.
  NX will only change the compiler used (breaking binary compatibility) in a functional release and will not change it more than once a year. During the functional release, the compiler may change and APIs may be retired per the deprecation policy for deletion.

• **Deprecation policy**
  If an API change requires you to make source code changes, you are given notice one year in advance, if possible. For example, if a method is going to be replaced by a new method, the original method is marked as deprecated in NX 1847, which is the release family. The original method is maintained through the current release family and through the next release family also, after which the API may be retired and removed.
  The what’s changed reports in the Documentation Center and, if possible, compile time warnings are used to warn you of changes made in the current release and changes coming in the next release.
The deprecated items topic in the Documentation Center provides a list of the deprecated methods and their replacement methods. For more information about the Documentation Center, see NX Open Differences between releases.

Note:

NX development makes every effort to follow the above policies. However, there may be instances when the policies must be violated due to the type of changes required. When this type of change is made, it is published on the Changes That May Require Code Changes tab in the Documentation Center. This includes information on the change that happened and suggests changes that could be made to the code.

NX maintains and publishes stability metrics that show that for at least the last 10 years the stability of the NX Open APIs is above 96% for any given release, while the average is above 99%.

Exploring changes to the NX Open API between releases

NX Open changes are published in the Documentation Center. In the NXOpen APIs section for your release, you can view API changes in the NXOpen APIs What's Changed Reports.

By default, this webpage contains the reports of the current release and the last functional release. In addition, you can select a release to compare with your release to get a comparison between the two releases. You can get comparisons for up to two years of releases.

Each page presented provides a point-to-point comparison of the APIs. The What's New tab on the page presents the new API items added between the two selected releases. The Changes That May Require Code Changes tab provides information that shows the changes that violate API stability and (or) binary compatibility, in accordance with the rules specified in the above policies.

For example, removing API items violates our API stability and binary compatibility policy unless the compiler changes. For each entry, we provide remediation suggestions, if needed, and possibly the reason for the change. An example of a change for which the only remedy is to recompile, is if a class has a new base class inserted into it's hierarchy. In this case, you don't need to change your code, but you do have to recompile your automation code that uses the API. This is contrasted by changes to a method signature to add an additional parameter. In this case, there will be a description of what the new parameter's purpose is and how to use it.

Also, the Changes That May Require Code Changes tab lists all of the deprecated APIs, their replacement APIs, and the earliest that each API could be retired. APIs that are retired are listed on the tab, along with when the API was removed and their replacement.

Open C API changes are listed in the NX release notes, in the New Open C routines, Obsoleted Open C routines, and Deleted Open C routines topics.

Function declarations that are newly retired (obsolele/deprecated) are moved to the uf_retiring.h file, which contains a complete list of Open C functions that could be deleted in the next NX release.
Release upgrade process for a functional release

For each functional release of NX, you should perform the following steps to migrate your application to the release:

1. Review the Changes That May Require Code Changes tab for the release you are going from and upgrading to. This helps you to understand what changes are being made in the release and what changes are planned for the next release.

2. For any methods or properties that have been deleted and for those which you have not already replaced in your code, implement the replacement code.

3. Recompile your entire source base using the current compile time files and settings for the given release.

4. For any methods or properties that produce deprecation warnings, decide if you are going to replace this code now or in the next release. Implement the replacement code for any deprecated methods you want to replace now and recompile.

5. Link your application with the appropriate NX Open libraries.

6. Perform a full suite of application testing in a stable NX environment.

7. Distribute your applications to your user base.

Release upgrade process for a monthly release

For each monthly release of NX, you should perform the following steps to migrate your application to the release:

1. Review any changes for the monthly release in the Documentation Center.

2. Any API changes that may require rework or a recompile of your code will only be made if absolutely necessary. In this case, you will have to rework or recompile the affected applications, then test and redistribute. These changes are provided in the Documentation Center.
Product Notes

Certified compilers and environments to use for NX Open programs

The following table specifies the compiler (or installation for Python) to use for the applicable platform. These certified compilers are the ones used in testing for a particular release. These are the only ones certified for use with NX Open:

<table>
<thead>
<tr>
<th></th>
<th>Windows</th>
<th>Linux</th>
</tr>
</thead>
<tbody>
<tr>
<td>C/C++</td>
<td>Visual Studio 2017 Build 19.10.25017</td>
<td>gcc 4.8.5</td>
</tr>
<tr>
<td>.NET</td>
<td>.NET 4.6.2 Framework</td>
<td>N/A</td>
</tr>
<tr>
<td>Java (64–bit)</td>
<td>JDK 1.8.0_45</td>
<td>JDK 1.8.0_45</td>
</tr>
<tr>
<td>Python (64–bit)</td>
<td>Python 3.7.4</td>
<td>Python 3.7.4</td>
</tr>
</tbody>
</table>

Use of a non-certified compiler

- **C++**
  For Windows, any version of a Visual Studio compiler should work within the release family as long as the version is equal to or higher than the certified version.
  For Linux and gcc versions, any version of gcc should work as long as the version is equal to or higher than the certified version and in the same release family.

- **.Net**
  The .Net framework provided by Microsoft attempts to maximize backward compatibility. The version used should be equal to or greater than the certified version. Additional information is provided by Microsoft at [Version Compatibility in the .NET Framework](#).

- **Java**
  Java has historically allowed programs compiled with earlier compiler versions to work with later JRE versions. This means that users can choose to compile at the certified compiler level and run with a later JRE version, or choose to compile at a compiler level greater than or equal to the certified compiler.

- **Python**
  The Python version that NX delivers is built at the certified version for the release. In addition, Python is binary compatible in a major release family, so for example, if we build and certify against X.Y.4, our NX Open Python binaries will be binary compatible for all releases in the X.Y series (X.Y.5, X.Y.6, and so on). But they will not be binary compatible with a different major release family, for example, the X.Z series (X.Z.3, X.Z.4, and so on).
Using a non-certified compiler or environment is not without risks, which is assumed by the user. If an issue arises using a non-certified compiler or environment, Siemens PLM Software can investigate with the following caveats:

- We need to be able to reproduce the issue easily so we can investigate the problem.

- If the compiler or environment regresses, it is expected that the user will investigate the issue in their environment to rule out improper usage on their part. For example, it is expected that users will rule out scenarios where the latest version of the compiler or environment fixes a bug that now catches something invalid that wasn’t caught before in a previous version.

- There exists the possibility that the solution to the issue encountered cannot be realized in the release reported, but will be deferred to a later release.

**Running Java and .NET programs**

To run programs created in NX Open that require Java or .NET, the following is required:

<table>
<thead>
<tr>
<th></th>
<th>Windows</th>
<th>Linux</th>
</tr>
</thead>
<tbody>
<tr>
<td>.NET</td>
<td>.NET 4.6.2 Framework</td>
<td>N/A</td>
</tr>
<tr>
<td>Java (64–bit)</td>
<td>JRE 1.8.0_45 or later</td>
<td>JRE 1.8.0_45 or later</td>
</tr>
</tbody>
</table>

**Note:**

Some standard NX applications, such as translators, require installation of the JRE. For additional information, see Considerations and caveats.

**Internet browsers**

If you do not see the latest documentation for the following programming tools, it may be a cache issue. Try clearing your cache, or using a different browser.

- *Open C Reference Guide*

- *NX Open C++ Reference Guide*

- *Open for Java*

- *NX Open Python*

- *Open for .NET*
In the *Open C Reference Guide*, if links to the example `.c` files do not work in IE, the `.c` file may not have an associated program to open it. Follow the instructions for your operating system to associate the `.c` file to a program, such as Notepad.

**Signing applications**

An executable for an application created with NX Open must be *signed* before it can be executed by anybody who does not have a NX Open Author license. This typically includes the primary users of the executable, such as mechanical designers at your site. The signing process is performed with the NX Open signing utility before the application is distributed to the user base.

Starting in NX 1872 for C++ executables, and NX 1899 for .Net executables, you can sign the executable using the NX Open signing utility and also have the executable digitally signed. Previously, you could not do both as the NX Open signing process was not compatible with digital signing.

Adding digital signing provides an additional level of security and protection especially if the application is going to other sites. Digital signing can be done by a Microsoft approved third-party certificate authority (CA), or you can perform your own digital signing.

Starting in NX 1899, for C++ and .Net Open applications, the version of NX you use to sign the application is injected into the signature. This information can be seen by using the `-verify` option with the appropriate signing tool.
Siemens Industry Software

**Headquarters**
Granite Park One
5800 Granite Parkway
Suite 600
Plano, TX 75024
USA
+1 972 987 3000

**Europe**
Stephenson House
Sir William Siemens Square
Frimley, Camberley
Surrey, GU16 8QD
+44 (0) 1276 413200

**Americas**
Granite Park One
5800 Granite Parkway
Suite 600
Plano, TX 75024
USA
+1 314 264 8499

**Asia-Pacific**
Suites 4301-4302, 43/F
AIA Kowloon Tower, Landmark East
100 How Ming Street
Kwun Tong, Kowloon
Hong Kong
+852 2230 3308

About Siemens PLM Software
Siemens PLM Software is a leading global provider of product lifecycle management (PLM) software and services with 7 million licensed seats and 71,000 customers worldwide. Headquartered in Plano, Texas, Siemens PLM Software works collaboratively with companies to deliver open solutions that help them turn more ideas into successful products. For more information on Siemens PLM Software products and services, visit www.siemens.com/plm.

© 2019 Siemens. Siemens, the Siemens logo and SIMATIC IT are registered trademarks of Siemens AG. Camstar, D-Cubed, Femap, Fibersim, Geolus, I-deas, JT, NX, Omneo, Parasolid, Solid Edge, Syncrofit, Teamcenter and Tecnomatix are trademarks or registered trademarks of Siemens Industry Software Inc. or its subsidiaries in the United States and in other countries. All other trademarks, registered trademarks or service marks belong to their respective holders.